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Barnes & Noble, Inc. 122 Fifth Avenue, New York, NY 10011 USA. 

© 2009 Barnes & Noble, Inc. All rights reserved. nook and the nook logo are trademarks of 
Barnes & Noble, Inc. or its affiliates. 

Screenshots and product images are simulated and for instructional purposes only. They may 
differ from the actual product and are subject to change without notice.  Your use of the nook 
is subject to the nook Terms of Service located here: www.bn.com/nook/legal. 

About this Guide 
This User Guide documents all features of the nook. It is available as an eBook in your nook 
library. It is also available for download from the nook Support website in PDF format: 

If you want a printed copy of the User Guide, you can print the PDF from Adobe Acrobat 
Reader. 

www.bn.com/nook/support 

Quick Start Guide 

The Quick Start Guide covers the basics needed to get you started. It is printed and in the box, 
as well as in the Library and at the above website. 

Tour 

Get the most out of your nook. The Tour takes you on a tour of your nook’s features. It is in 
the Library and at the above website. 

Using this Guide 

You can browse this guide, locate information through the table of contents, and search in the 
guide. 

The eBook version is an eBook, so you can try out nook features using the User Guide. 
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Conventions 

Following are conventions used in the User Guide: 

 
This is a caution. 

 

 

This is a note. 

Guide Updates 

If needed, new versions of the User Guide, Quick Start Guide, and Tour will be made available 
automatically through software updates. The updated documents appear in your online digital 
library. You will receive a notice about their availability, and will have the option of delivering 
them to your nook. 

Guide updates are also posted to the Support website: 

More Information Online 

www.bn.com/nook/support 

More information is available online: 

 FAQs 

 Known Issues and Solutions 

This information is available on the Support website: 

www.bn.com/nook/support 

http://www.bn.com/nook/support�
http://www.bn.com/nook/support�
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Welcome 
Welcome to the nook! The nook is a portable eContent storefront, library, and eReader. But 
it is also much more. 

 

When you first turn on your nook, it will lead you through registration, if your nook 
is not pre-registered. If you do not have a Barnes & Noble account, you can create 
one from your nook or online. After registration, your nook will download 
information about the eContent in your online digital library. Information about 
registration is in the chapter “Registration.” 

Hardware highlights 
The nook has: 

 Main reading screen: The reading screen. An 800 x 600, 4.82 x 3.57 inch (6-inch 
diagonal), reflective high-resolution E Ink electronic paper display. The main screen displays 
16 levels of gray. 

 Secondary touch screen: A 480 x 144 color touch screen is used for menu navigation, D-
pad navigation, a keyboard, and display of cover thumbnail graphics. The touch screen 
supports gestures (for example, tapping your finger to choose a menu item and swiping 
your finger to scroll through eContent covers). The screen brightness is controlled by an 
ambient-light sensor (or you can set a fixed level). 

 Cellular and Wi-Fi connectivity: Your nook uses the AT&T cellular network for its main 
connectivity to the Barnes & Noble online store and to nook data services such as your 
online digital library. When in a Barnes & Noble store, or when a Wi-Fi connection is 
manually configured, the nook preferentially uses Wi-Fi. 

 Speakers and a headphone jack: Your nook has two small speakers for audio. For better 
sound quality, you can use headphones. 

 A USB socket: Your nook has a USB socket for managing files from a personal computer. 
It is also used for charging. 
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Feature highlights 
What can you do with your nook? Here are some highlights: 

 The Daily: The Daily is a daily bulletin from Barnes & Noble that contains topical humor, a 
digest of review content, an article of the day, special events and promotions, and 
notifications, for example about offers to lend you books. 

 Shopping: With your nook, it is easy to buy eBooks, eMagazines, and eNewspapers from 
the Barnes & Noble store. Some content is even free! You can also download non-DRM 
content to the nook from your personal computer. 

 In-Store content and merchandising: When you bring your nook into a Barnes & Noble 
store, you can access in-store content and merchandising. This includes the ability to read 
any eBook while in the store! Merchandising content includes in-store, exclusive editorial 
content, promotion coupons, and information about in-store events. 

 Library: The Library provides access to your B&N content and to your personal files, such 
as music. For B&N content, you have a unified view of the content on your nook and in 
your online digital library. You can browse and search for content in the Library. 

 Reading: You can read eBooks, eNewspapers, eMagazines, and The Daily on your nook. 

 Bookmarking, highlighting, and annotating: While reading an eBook, you can bookmark 
pages, highlight text, and add annotations. When you lend an eBook, you can lend it with 
or without your bookmarks, highlighting, and annotations. 

 Lending eBooks: You can lend an eBook in your Library to a friend. 

 Ratings and Recommendations: Are you reading a good eBook or ePeriodical? You can 
rate the eBook from your nook. You can also recommend it to friends. 

 Personal content and audio: You are not limited to B&N content on your nook. You can 
download non-DRM eContent to your nook from your personal computer. You can listen 
to music while reading. You can also listen to audiobooks. 
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Safety 
If you follow some straightforward precautions, the nook is a safe device. 

Electricity 

The nook is an electrical device. Only use an approved charger. If you open the back cover, 
unplug the device from the charger and turn it off first. 

Water 

The nook is not a waterproof device. If it starts to rain, get under cover or put the nook away. 
Don’t read it in the bathtub. You could ruin your nook. 

Situations that Demand Your Attention 

Some situations demand your attention. If you shouldn’t be reading a book while doing them, 
then you shouldn’t be reading on your nook either. Driving? Don’t even think about it. 
Operating a train? Don’t be daft. We don’t want to hear about you on the evening news (even 
with the mention of the “apparently engrossing eReader”). Watching children? Yes, but only if 
you can do it in a way that fairly divides your attention and does not endanger them. Use 
common sense—the eBook will still be on your nook to read tomorrow. 

Airplanes 

To use your nook on an airplane, set it to Airplane mode. More information about use on 
airplanes, see the section “Airplanes.” 

Electronic Equipment 

If you are around sensitive electronic equipment, for example in a hospital, ask if you may use 
your nook. You probably can if you set it to Airplane mode, except in an intensive care setting. 
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In the Package 
The package the nook comes in contains four things: 

 Your nook 

 A charger that can be plugged into an electrical outlet. It has a polarized type-A plug for 
use in North America. One prong is wider than the other, and the plug only fits in the 
outlet one way. The standard-A plug on the USB cable (the big end) fits into the charger, 
to connect the charger to your nook. 

 

 A USB cable for transferring files to and from a personal computer, and for USB and wall 
charging. The USB cable has a micro-B plug on the nook end and a standard-A plug on the 
computer end. It is shielded against electromagnetic and radio-frequency interference, a 
prerequisite for high-speed data transfers. 

 

 A printed Quick Start Guide 

 

The battery is preinstalled in the nook. 

You can save the package as a convenient place to store your nook when not in use, and as an 
inner shipping box in the event you need to send your nook in for repairs or replacement. 
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Optional Accessories 
Optional accessories are available at your local Barnes & Noble retail store and online at 
BN.com. Some are only available online. If you purchase an accessory from a vendor other 
than BN.com, ensure that it is compatible with the nook. 

Cover 
You can purchase a cover for your nook at your local Barnes & Noble retail store or online 
from BN.com. The cover helps protect your nook from daily wear and tear. For example, it 
keeps dust from accumulating on the screens, reducing the need to clean them. It provides 
some protection against spills. 

 
The cover of the nook has a strap that holds it in place. The strap has a small magnet 
in it. Keep the magnet away from things you do not want demagnetized, like credit 
cards and transit tickets. 

Wall Chargers 
You can purchase additional and replacement wall chargers online at BN.com. 

If considering other wall chargers, they should have the following characteristics: 

 Polarized fixed prongs for North American wall sockets and a micro-B USB plug for 
connection to the nook 

 50/60 Hz, 0.25 amp,110/240 volt alternating current (VAC) switching input 

 5 volt, 0.85 amp output 

USB Cables 
You can purchase additional and replacement USB cables online at BN.com. 

You can use any USB 2.0 compatible USB cable that has a standard-A and micro-B plug. If you 
use a different USB cable than the one in the box, we recommend a shielded one.  
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Charging and Power 
Your nook is pre-charged at the factory. Depending on the battery indicator when you first 
turn it on, you might want to charge it fully before using it. 

Low Charge Alerts 
If you turn on your nook and the battery charge is too low, your nook displays a message to 
charge it. 

Charging Indicator 
Your nook has a charging indicator LED next to the data/charging port: 

 

 When your device is charging, the charging indicator is lit yellow-orange. 

 When the device is fully charged, the indicator LED is not lit. 

Charging 
Charge your nook using: 

 A wall charger. You can use the supplied charger connected to your nook through the 
supplied USB cable. If you use a different charger, check the information in Accessories to 
ensure that you use a compatible one. 

  A USB cable (the supplied one or a different one) 
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Wall charging is faster than USB charging. Approximate charging times from fully discharged to 
fully charged are: 

 Wall charger: 3.5 hours 

 USB charger: 6 hours 

Wall charging 
 

 
Only use the supplied wall charger or a charger with the following characteristics. 
Other chargers might damage your battery and nook: 

 Polarized fixed prongs for North American wall sockets and a micro-B USB plug 
for connection to the nook 

 110/240 volt switching input 

 4.25 W (5 V, 850 mA) output 

For wall charging, the device can be off, sleeping, or on. The time required for charging does 
not differ appreciably for these modes. You can use your nook while it is charging. 

Procedure 

1 Assemble the wall charger. Insert the large end of the USB cable into the matching 
receptacle on the charger. 

2 Plug the nook end of the wall charger into the nook. 

3 Plug the wall end of the wall charger into a compatible electrical outlet. Your nook charges. 

When charging, the charging indicator LED to the left of the USB port lights up yellow-
orange. 

4 When the nook is fully charged, the charging indicator LED goes out. 

5 Unplug the wall charger from the electrical outlet and unplug the USB cable from your 
nook.  
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USB charging 

 
The first time you connect your nook to a personal computer, your nook should be 
on. The computer will install USB drivers for the nook, and display a message that 
this operation is in progress. It will also display a message when it completes installing 
drivers. You can ignore these messages. They do not affect charging. 

For USB charging, the device can be off, sleeping, or on. 

Procedure 

1 Power on your personal computer. 

2 Plug the smaller end of the USB cable into the USB/charging port on your device. 

3 Plug the larger end of the USB cable into a USB port on your computer. The USB cable 
connections are shown in this drawing: 

 

What happens now depends on power state your nook is in: 

 Off: Your nook charges. 

 Sleeping: Your nook charges. A popup prompt regarding accessing mass storage is 
displayed behind the screensaver. You see the prompt when you wake your nook from 
sleep. 

 On (including when the touch screen display is off): If the touch screen display is off, it 
is turned on. Your nook charges. You are presented with a choice regarding accessing 
mass storage. 

When charging, the charging indicator LED to the left of the USB port lights up yellow-
orange. You can use your nook while it is charging. 
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4 When the nook is fully charged, the charging indicator LED goes out. 

5 Unplug both ends of the USB cable. 

Charging Recommendations 
Your nook contains a lithium ion battery. To maximize battery life: 

 Partially discharge the battery, as a rule, rather than fully discharging it. This is also better 
from the standpoint of use. A fully discharged nook must charge for about 30 minutes 
before it will turn on. 

 Avoid high temperatures if possible for use and storage. 

 Charge the battery half way before storing your nook for a week or more. 

 Turn your nook off for storage. If you are going to store your nook for more than a 
week, turn it off.  

Power Button 
The shiny metal strip at the top of your nook is the power button: 

 On: If your nook is off, the touch screen is off, or your nook is asleep, press and release 
the power button to turn on your nook. 

 Sleep: If your nook is on, press and release the power button to cause your nook to sleep. 

 Off: If your nook is on, press and hold the power button for 5-9 seconds to turn off your 
nook. You will usually not need to turn your nook off. 

When the touch screen is dark but your nook is not asleep, you can also awaken it by tapping 
the Home button or double-tapping the touch screen. 

Power Management 
Your nook uses quite modest amounts of power compared to a laptop computer. It uses a 
small amount of power to turn a page on the reading screen, but no power to keep the page 
displayed. The touch screen does use power when it is lit. 
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To allow you to manage power use, and to give you the experience that suits your reading 
habits, you can configure two inactivity periods: 

 Touch screen timeout: Time from last touch screen activity until touch screen backlight is 
turned off. You can choose among 10, 30 (default), and 60 seconds. 

 Sleep timeout: Time from last activity (touch screen or button presses) until the nook 
sleeps. During sleep, a screensaver picture is displayed on the main screen. The touch 
screen will already be unlit. You can choose among 2, 5 (default), 10, 15, and 20 minutes. 

Device States 
Your nook is in one of five states, which affect power consumption when not charging. You 
can charge your nook in any of these states, if it is attached to a wall charger or USB cable. 

Off 

When you first take your nook out of the package, it is off. You can also turn your device off 
when not in use. 

 

Because the main screen does not consume power, you might just let your nook 
sleep. It takes longer for your nook to turn on from off than it does to wake from 
sleep. 

To turn your nook off when it is on or sleeping, do either of the following: 

 (Recommended) Press and hold the power button for 5 to 9 seconds, then release the 
button. This shuts down your nook “nicely,” so your nook can finish what it was doing 
before it turns off. 

 Press and hold the power button for 10 or more seconds. This turns your nook off 
immediately, possibly without finishing what it was doing. When it turns off, release the 
button. 

On 

When your nook is on, everything works. The main and touch screens are both lit, and you 
can read content and listen to music or audiobooks. If Airplane mode is on, you will not be 
able to do things that require the radio, such as shopping at the B&N store. 
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When your nook powers on, it displays a splash screen and then returns you to where you 
were when it shut down. It also scans the SD card to check for changes in content. 

To turn your nook on from sleep, do any of the following: 

 Press the power button briefly (for a second or so) and release it. 

 Open the B&N cover (an optional accessory), if you are using one. In this case, you do not 
have to press the power button. 

 Connect your nook to a personal computer using the USB cable. This displays a dialog that 
asks if you want to enter Mass Storage Mode (and lock your device). 

 Begin charging your nook using a wall outlet. 

If you are just charging your nook and don’t need it to be on, don’t worry about it waking up. 
It will just go back to sleep. 

To turn your nook on from off: 

 Press the power button briefly (for a second or so) and release it. 

 Press and hold the power button for 5 to 9 seconds, and then release it. If you press the 
power button for 10 or more seconds, the device will start to turn on but will turn off 
again. 

 Connect your nook to a personal computer using the USB cable. This displays a dialog that 
asks if you want to enter Mass Storage Mode (and lock your device). 

 Begin charging your nook using a wall outlet. 

If you are just charging your nook and don’t need t to be on, don’t worry about it turning on. It 
will go to sleep. 

Touch Screen Display Turned Off 

After a period of not using the touch screen, the touch screen display turns off. This is to save 
power. Everything else is still on. You can continue turning pages with the Next and Previous 
buttons. You can continue listening to music or an audiobook. 
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The setting that specifies the time period is Touch Screen Timeout Period. 

To turn on the touch screen display, tap the Home button one time or double-tap the touch 
screen. 

Sleep 

After a configurable period of inactivity, your nook goes to sleep. This is to conserve power. 
When your nook is asleep, the touch screen display is turned off and a screensaver image is 
displayed on the main screen. 

 
Do not rely on sleep mode when you should turn on Airplane mode (for example, 
on an airplane). 

To awaken your nook from sleep, press the power button briefly (a second or so) and release 
it. This awakens the nook, exits the screensaver, and returns you to where you were when the 
nook went to sleep. 

Your nook also goes to sleep when you close the optional cover that is available from BN.com 
or a Barnes & Noble retail store. 

Mass Storage Mode 

Mass storage mode lets you manage B&N and personal content on the internal microSD card 
and supplemental microSD or microSDHC card, if there is one. 

You cannot simultaneously manage files through USB and use your nook, so the device is 
locked. 
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Your nook 
This section explains your nook hardware. It also tells how to care for your nook. 

Hardware Diagrams 
These diagrams show the parts of the nook and tell you what they do. 

Front View 

From top to bottom you see: 

 Reading screen: The upper screen is where you read. 

 Home button: The nook symbol between the reading and touch screens is a touch sensor 
that displays the Home menu. 

 Touch screen: The lower screen is a touch screen. It displays menus that let you control 
your nook. It also displays a keyboard when you need one. 

 Next buttons: The Next buttons let you turn to the next page in what you are 
reading and in a paginated list. 

 Previous buttons: The previous buttons let you turn to the previous page in what 
you are reading or in a paginated list. 

Top View 

The shiny metal strip in the center of the top of your nook is the power button. 

Bottom View 
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From left to right, you see: 

 A speaker 

 The headphone jack 

 The charging indicator 

 The USB/charging port 

 The other speaker 

Back Cover 
This section explains how to remove and replace the back cover of your nook. 

You should almost never have to remove the back cover. The only times when you need to 
remove the back cover are: 

 To insert a microSD card to add storage capacity to your nook, or to insert a larger 
microSD card 

 To replace the battery 

Removing the Back Cover 

 
The first time you do this, you might want to do it over a soft surface such as a sofa 
cushion, in case you drop your nook. The back cover is biased toward staying on, 
rather than toward coming off. 

To remove the back cover: 

1 Unplug your nook from the wall charger or USB cable. 

2 Press the power button for between 5 and 9 seconds to turn off your nook. 

3 Hold your nook in one hand with the back facing away from your hand and the bottom 
edge way from you. Hold the nook by your finger tips with two fingers on the bottom of 
the nook. 
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4 Locate the tab protruding from near the center of the bottom of the back cover, adjacent 
to the USB port. 

5 Place a finger of your other hand on the tab and pull the tab away from the device. The 
back cover will start to separate from the nook. The tab will move away from the nook, as 
will one or both of the adjacent corners of the back cover. As the back cover separates 
from the nook, you will hear unsnapping sounds. 

6 Separate the other adjacent corner if it did not already separate. 

7 Moving your fingers of the hand holding the cover 1/3 of the distance toward the end of 
the cover that is still connected to the nook, apply outward pressure (away from the nook) 
on the cover. You can also insert a finger between the nook and back cover and pry the 
nook and cover apart. You will hear more unsnapping sounds and the cover will come free. 

Attaching the Back Cover 

To attach the back cover: 

1 Hold the nook in one hand by your fingers with the back facing away from your hand and 
the bottom edge closest to you. 

2 Hold the back cover in the other hand with the inside facing away from your hand and the 
bottom edge closest to you. The bottom edge has a little tab near the center. Notice the 
five hook-shaped projections inside the back cover. These snap into corresponding slots in 
the back of the device to hold the back cover in place. 

3 Place the bottom edges of the nook and back cover together. Holding the nook and cover 
together, turn them into the reading position, with your hands on the nook as they would 
be for reading—fingers below and thumbs above. 

4 Using both hands, apply gentle pressure along the white margins of the front of the nook, 
starting about one quarter of the way up and moving upward along the edges and then to 
the middle of the top edge. 

 
Do not press on the other parts of the front of the nook. And do not bend the 
nook. Doing so might damage the screens. 
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As you press the edges together, you will hear snapping sounds as the hooks snap into 
place. 

5 Look around the edges of the nook to see that the back cover is securely attached. If the 
back cover is not securely attached, press edges together that did not seat correctly. If that 
does not work, remove the back and repeat this procedure. 

SIM Card 
The AT&T SIM card in your nook is pre-installed and permanent. It is used when the nook 
connects to the online Barnes & Noble store and nook data services over the AT&T cellular 
network. You will never need to remove or change the SIM card. Specifically, please note the 
following about the SIM card: 

 You cannot use the nook SIM card in a different mobile device, for example, a mobile 
phone. 

 You cannot use a different AT&T SIM card, for example, from a mobile phone, or a SIM 
card from a different carrier, in the nook. 

 The SIM card in your nook is associated with your nook, whether registered or not. Do 
not swap SIM cards between nooks. There is no reason too, and afterwards they will not 
be able to connect to the cellular network. 

Built-in Storage 
Your nook has 2 GB of built-in flash memory. Of this, about 1.75 GB is available for storage of 
your eContent. This is enough storage space for about 1500 eBooks or 300 ePeriodical issues. 
ePeriodicals tend to be larger because they have more graphical content. 

 

The storage capacity for eBooks and other eContent will be affected by how many 
personal files (for example, music files) you download onto your nook. 

Adding Storage 
If you want to increase the storage capacity of your nook, you can purchase and insert a 
MicroSD or microSDHC card. 
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Supported Cards 

Following are the specifications of supported cards: 

 A microSD or microSDHC card with a storage capacity of up to 32 GB. For simplicity’s 
sake, we refer to these both as microSD cards below. 

 Class 2, 4, and 6 microSD cards are supported. Class 6 is faster than class 4, which is faster 
than class 2. The class should be mentioned on the packaging for the microSD card and 
printed on the card itself. If no speed is indicated, the card is a class 2 card. The speed of 
the card does not affect page display speeds. It can affect read and write speeds when 
transferring eBooks and personal files to and from the SD card. 

Approximate Storage Capacities 

Supplemental microSD and microSDHC cards will hold about 750 eBooks per gigabyte or 300 
ePeriodicals per gigabyte. 

Inserting a microSD Card 

To insert a microSD card: 

1 Press the power button for 5-9 seconds to turn off your nook. 

2 Remove the back cover. 

3 Place your nook on a flat surface with the open back facing up and the top away from you. 

4 The microSD card holder has a little metal cover. A rounded, cut-out area below the cover 
allows you to insert a finger nail. With your finger nail, lift up on the bottom edge of the 
metal cover, until the cover points straight up. In the space for the microSD card, you see 
eight contacts toward the top of the holder (near the hinge). 

5 With the contacts on the microSD card facing down and lined up with the contacts in the 
holder (the thicker base toward you and the notch to the right), drop the microSD card 
into place. You might need to move it around a bit. It should fit snuggly. 

6 With a finger, close the metal cover until it lies flat and you feel a click. 

 
If the cover does not close easily, do not force it. Doing so will damage the microSD 
card holder. Instead, ensure that the microSD card is correctly positioned (contacts 
facing down and the notch to the right and flat and snug in the holder), and then try 
again. 



 

nook User Guide  26        

7 Replace the back cover. 

8 Power on your nook. 

Removing a microSD card 

To remove a microSD card: 

1 Press the power button for 5-9 seconds to turn off your nook. 

2 Remove the back cover. 

3 Place your nook on a flat surface with the open back facing up and the top away from you. 

4 The microSD card holder has a little metal cover. A rounded, cut-out area below the cover 
allows you to insert a finger nail. With your finger nail, lift up on the bottom edge of the 
metal cover, until the cover points straight up. This reveals the microSD card. 

5 Pick up your nook. Holding it over the table, turn it over so the front is up. The microSD 
card will fall out and land on the table. Pick it up and put it somewhere. 

6 With a finger, close the metal cover until it lies flat and you feel a click.  

7 Replace the back cover. 

8 Power on your nook. 

Changing microSD Cards 

If you decide to change the microSD card in your nook (take one out you are currently using 
and put a different one in), note the following: 

 For personal content on the microSD card, you must transfer the content manually, using a 
USB connection to a personal computer. Using a file explorer, copy or move the content 
to your personal computer. After inserting the new microSD card in your nook, copy or 
move the content to the new microSD card in your nook. Copying is a better idea than 
moving, because you have backup copies. After you have verified that the copy operation 
succeeded, you could delete unneeded files. 

 For B&N content, we also recommend that you transfer the content using a USB 
connection to a personal computer. The reason is that it is much faster than transferring 
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the data over a cellular network connection. A Wi-Fi hotspot has an intermediate speed. 
Manually transferring content through USB also saves you from having to pick and choose 
what you want to be downloaded again from the online digital library. 

 You can re-download B&N content from your online digital library to your nook. 

To change the microSD card: 

1 Press the power button for 5-9 seconds to turn off your nook. 

2 Remove the back cover. 

3 Place your nook on a flat surface with the open back facing up and the top away from you. 

4 The microSD card holder has a little metal cover. A rounded, cut-out area below the cover 
allows you to insert a finger nail. With your finger nail, lift up on the bottom edge of the 
metal cover, until the cover points straight up. This reveals the microSD card. 

5 Pick up your nook. Holding it over the table, turn it over so the front is up. The microSD 
card will fall out and land on the table. Pick it up and put it somewhere. 

6 Place your nook on a flat surface with the open back facing up and the top away from you. 
The metal holder should be open. 

7 With the contacts on the new microSD card facing down and lined up with the contacts in 
the holder (the thicker base toward you and the notch to the right), drop the microSD 
card into place. You might need to move it around a bit. It should fit snuggly. 

8 With a finger, close the metal cover until it lies flat and you feel a click. 

 
If the cover does not close easily, do not force it. Doing so will damage the microSD 
card holder. Instead, ensure that the microSD card is correctly positioned (contacts 
facing down and the notch to the right and flat and snug in the holder), and then try 
again. 

9 Replace the back cover. 

10 Power on your nook. 
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Media Scanning After a microSD Card Change 

If you turn your nook completely off before inserting, removing, or changing the microSD card 
(as recommended), then when your nook turns on, it scans the microSD card to look for 
changes and updates the library catalog accordingly. 

If you inserted, removed, or changed the microSD card with the device on or sleeping, this 
media scan does not happen. 

To cause it to happen, do either of the following: 

 Turn your nook off (completely; not just sleep) and then turn it on again. 

 Attach your nook to a personal computer using the USB cable and choose Mass Storage 
Mode. Then detach your nook from the personal computer. 

Battery 
You do not install the battery. It is pre-installed and permanently installed. It should last for 
years. 

Replacing the Battery 

If necessary, the battery can be replaced. A replacement battery must be of the following type: 

Barnes & Noble Lithium Polymer battery 
Model Number BNRB1530 
Rating: 3.7V, 1530mAh, 5.66Wh 

You will need a small Phillips head screw driver (size 0 or 00). To replace the battery: 

1 Unplug your nook from the wall charger or USB cable. 

2 Turn off your nook. 

3 Carefully remove the back. Full instructions for that are given in the section “Removing the 
Back Cover.” 

4 With the back facing you, turn the nook so that the top is directed away from you. The 
screw and tab holding the battery in place are at the top of the battery. 
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5 Unscrew and remove the screw that holds the battery in place. Sit it down where it won’t 
get lost. You will need it in a moment. 

6 Lift the battery out as if it has a hinge long the bottom edge. Insert your finger nail in the 
semicircular space at the upper left of the battery, press against the top of the battery 
(pressure toward the bottom of the nook), and move your finger upward. The top edge of 
the battery should rise up out of the slot that holds the battery. 

7 Grasp the battery with your other hand, and lift it out. 

8 Insert the replacement battery. Insert the two tabs on the top edge of the battery in 
matching slots in the bottom edge of the battery compartment. Lower the top edge into 
place. The battery should lie flat. 

9 Screw in the screw. 

10 Replace the back cover. Full instructions for this are given in the section “Replacing the 
Back Cover.” 

Wireless Connectivity 
While reading and during most tasks, the radio in your nook is not on. It does not need to be, 
and it would consume power. Even browsing your Library, including B&N content in your 
online digital library, is done on the nook. However, some tasks, such as browsing or searching 
the B&N Store, do require a wireless connection. When the nook needs a connection, it starts 
the radio, determines the best network to connect to (AT&T cellular or Wi-Fi), and connects. 
When it no longer needs the connection, it disconnects. 

You nook uses the best network it can find, considering network speed and signal strength: 

 In a Barnes & Noble store, your nook uses the store’s Wi-Fi hotspot. 

 If you configure other Wi-Fi hotspots, it uses those preferentially when it needs a network 
connection (if the signal strength is OK). 

 If a Wi-Fi hotspot is not available, your nook uses the AT&T cellular network. Again, it 
picks the best cellular connection based on speed and signal strength. 
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Cellular Network 

Your nook can connect to AT&T cellular networks in the United States. 

 
Your nook cannot connect to other networks in the United States that provide 
cellular service to AT&T customers through roaming, including the networks of 
regional AT&T affiliate carriers. It cannot connect to any international networks, 
including those in Canada and Mexico. Wi-Fi connectivity is possible globally. 

The cellular radio connectivity is 850/1900 MHz dual band. It can use GSM (2G), GPRS 
(2.5G), EDGE (3G), UMTS W-CDMA (3G), and HSDPA (3.5G) cellular networks. The nook 
automatically connects to the fastest network present that has sufficient signal strength. On an 
HSDPA network, the maximum uplink speed is 350 kbps (kilobits per second) and the 
maximum downlink speed is 3.2 Mbps (megabits per second). Typical downlink speeds for an 
HSDPA network are 400 to 700 kbps. 

Wi-Fi 
Your nook can connect to Wi-Fi hotspots that use the 802.11b or 802.11g standard (that is, 
almost any Wi-Fi hotspot, if the other requirements are met). The radio frequency is 2.4 GHz. 
The supported bandwidth is 11 Mbps for 802.11b and 54 Mbps for 802.11g. 

Wi-Fi Hotspots 

Your nook can connect to specific Wi-Fi hotspots (places that offer wireless Internet access). 

 Your nook automatically detects and connects to Wi-Fi hotspots in Barnes & Noble stores. 

 Your nook automatically detects Wi-Fi hotspots networks that broadcast their network 
name (Service Set Identifier, or SSID). It does not automatically connect to them, but in 
Settings you can add detected networks to the list of networks to which your nook 
connects. 

 You can configure one or more Wi-Fi hotspots, irrespective of whether they broadcast 
their SSIDs. For example, you can configure Wi-Fi settings for a home network or the 
coffee shop around the corner. If you configure other Wi-Fi hotspots, your nook 
automatically connects to them. 
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For a secured hotspot, you must provide the credentials needed to connect—the 
security type and security code. 

Dropped Calls and Lost Wi-Fi Connectivity 

If your nook is performing an action over the air and the call is dropped (for example, if the 
signal strength is poor), or if the Wi-Fi network goes down, it will do its best to resume what it 
is doing. If it can resume, it will not inform you about the lost connection. If it cannot resume, it 
will inform you that you should repeat the operation in an area with better signal strength or 
when the Wi-Fi network is up again. 

In Areas with No Wireless Connectivity 

In areas with no wireless connectivity (no United States AT&T cellular network, no B&N 
hotspot, and no manually configured Wi-Fi hotspot), you can still use your nook as an 
eReader. You can read anything that is in the local library on the nook. You can also obtain 
new B&N content through an Internet connection on your personal computer (buy eContent 
from the Barnes & Noble online store), and then transfer the files from your computer to your 
nook using the USB cable. 

Use on Airplanes   
The nook is a portable electronic device, and as its use on airplanes is regulated. Here is the 
story: 

 Always obey the instructions of the flight crew. They will inform you when you can and 
cannot use portable electronic devices. 

 Before pushback from the gate, you can use your nook with Airplane mode On or Off. 
This is the time to set Airplane mode to On, if you haven’t already done so. 

 During takeoff, your nook must be turned off (not just in Standby mode) and stowed. You 
cannot use it.  

 At cruising altitude, when instructed by the flight crew that portable electronic devices are 
permitted, you can use your nook with Airplane mode On. 

 During landing, your nook must be turned off and stowed. You cannot use it. 
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 After landing, you can use your nook with Airplane mode On or Off. 

Also remember that, on an airplane, material you read should be appropriate for a public 
setting. 

Turning Airplane mode On and Off 

Turning Airplane mode On turns the wireless circuitry off.  The nook will not send or receive 
radio signals until the Airplane mode is turned off. 

 
Turn Airplane mode On for the duration of an airplane flight, from take-off through 
landing. Turn Airplane mode On in other settings where radio signal broadcasting is 
prohibited. Ask someone whether Airplane mode should be turned On in other 
settings such as hospitals. 

Turning Airplane mode Off (the default setting) turns the wireless circuitry on, so the nook can 
send and receive radio signals. 

To turn Airplane mode On or Off: 

1 On the Home menu, tap Settings. 

2 Tap Airplane mode. 

3 Tap On or Off. 

Checked Baggage 

You will want to use your nook on the flight, of course, but we have to mention this. Rules are 
rules. If you travel on an airplane with your nook in checked baggage, the Federal Aviation 
Administration requires that: 

 Your nook is turned off (fully off, not just asleep). 

 Your nook is packed to prevent it from being turned on inadvertently. It should be packed 
so that nothing can press against the power button. This might take a bit of care. Packing 
the nook with its cover on will help. 
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Caring for Your nook 
Here are some recommendations about caring for your nook. If you follow them, your nook 
should have a long productive life. 

Temperature Range 
Your nook should function as designed in these temperature ranges: 

Use Fahrenheit Centigrade 

Charging 41– 95 ºF 5 – 35 ºC 

Operation 32 – 104 ºF 0 – 40 ºC 

Storage 5 – 113 ºF -15 – 45 ºC 

Outside of these ranges, your nook might develop power, display, and/or software issues. If 
temperatures are extremely cold or hot, permanent physical damage can result. Such damage 
is not covered by the warranty.  Storage applies to temporary locations like the trunk of your 
car (or other motor vehicle) as well as long-term storage. 

Even on a day that is not very hot, the passenger compartment or trunk of a car can 
be extremely hot. Do not leave your nook in a car. 

High storage temperatures reduce battery life. For more information, see the section 
“Charging Recommendations.” 

Water and Weather 
Your nook has a degree of water resistance, for example, to a misty fog. (We do want San 
Francisco residents to buy nooks.) If your nook gets damp, just dry the surface with a clean, 
dry cloth before you put it away. But don’t let your nook get too wet. It is not water proof. 
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Main Screen 
You do not need to touch the main screen, and should try to not do so. Fingerprints can 
permanently damage the main screen if they are not removed. If the screen gets fingerprints, 
grime, dust, or water on it (or for that matter, red wine, spaghetti sauce, or mustard), you 
should clean it. 

The main screen has a scratch-resistant coating, but it is possible to scratch the screen, so you 
should clean it carefully. Keeping the screen clean in the first place is a better strategy than 
cleaning it. You should clean it infrequently, not often. 

Touch Screen 
The touch screen is meant for touching, but you should also clean it. You might clean it after 
several days of use, or if you notice the screen needs cleaning. 

Cover 
You can purchase an optional cover for your nook at your local Barnes & Noble retail store or 
online from BN.com. The cover helps protect your nook from daily wear and tear. For 
example, it keeps dust from accumulating on the screens, reducing the need to clean them. It 
provides some protection against spills. 

For more information about the cover, see the section “Cover” in the chapter “Accessories.” 
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Operating the Controls 
This section explains all of the buttons and menus. 

Power Button 
The shiny metal strip at the top of your nook is the power button. In addition to being used to 
turn your nook on and off (which is explained in the section “Power and Charging”), you can 
use the power button to: 

 Awaken your nook if it is sleeping (this works for both the dark touch screen and full-sleep 
cases). You can also double-tap the Home button to awaken your nook. 

 Cause your nook to sleep if it is awake 

For more information about the power button, see Power and Charging. 

Home button 
The Home button has the nook symbol on it— . It uses a capacitive touch sensor. Tap or 
touch it; you do not need to press it. 

The Home button uses a capacitive touch sensor, capable of detecting a light touch. You don’t 
need to press it hard, and nothing moves up and down. 

Use the Home button as follows: 

 When your Nook is awake, tap the Home button to go to the Home menu. 

 When the touch screen is dark but your nook is not sleeping, tap the Home button one 
time (or double-tap the touch screen) to display the touch screen. 
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Next and Previous Buttons 
On each side of your nook, there are two buttons: 

 
(Next): Display the next page of content or of a paginated list. 

 
(Previous): Display the previous page of content or of a paginated list 

The Next and Previous buttons are typical buttons. When you press one, it moves down, and 
you feel and hear a mechanical click. When you do, you can raise your finger. You can also 
turn on feedback sounds, which include a button click sound. 

The Next and Previous buttons have a small dimple next to them; just to the right of the 
buttons on the right side of your nook and just to the left of the buttons on the left side of your 
nook. The touch dimples help you find the buttons by touch while reading content. 

Touch Screen 
The touch screen displays menus, navigation controls, and when needed, a keyboard. It also 
displays some messages. 

Reach applications including the Library, Store, and Reader from the Home menu. Submenus 
allow you to use all of your nook’s features. 

Gestures 
Typing is covered in the section “Keyboard and Typing” below. 

The touch screen recognizes several gestures: 

 Touch: When you touch a Home menu icon, menu choice, or key, the touch screen 
highlights the chosen item. But your nook does not perform the requested action until you 
raise your finger. 

 Tap: This is the most basic gesture for the touch screen. Briefly touch a menu or key and 
then immediately raise your finger. 
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If you tap very quickly, your nook might not register the tap (and the highlighting 
does not happen). If what you expect to happen doesn’t, try a longer tap. 

 Double-tap: Tap the same menu choice or key briefly two times in rapid succession. You 
can also double-tap the Home button to awaken your nook. 

 Swipe: Touch a spot on the touchscreen, move your finger to another point, and then 
raise your finger. 

 Scroll: If a context has more than four menu choices, not all of them will fit on the touch 
screen at the same time. The first four are displayed, along with a scroll bar. You can scroll 
up and down in the menus by swiping your finger. Swipe up to scroll down and vice versa. 

 Throw: If you swipe quickly in Cover View and your finger is still moving when you raise it, 
the covers continue to scroll for a little while. This is called “momentum,” and the gesture 
is to throw. 

Menus 
For everything that you are doing with your nook—reading, browsing the Store, buying a 
subscription, searching your Library, listening to music, and so forth—the touch screen displays 
context-sensitive menus. You use the menus to control what happens. For example, while 
reading, you can do all of these things: 

 Find a word or phrase 

 Go to the cover, table of contents, chapters, pages, and the furthest read point 

 Bookmark a page and manage bookmarks 

 Highlight or annotate, and manage highlights and annotations 

 Look up a word 

 Set Reader options, that is, the font and text size 

 Choose music to play or an audiobook to listen to 
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Home Menu 

The starting point for everything is to choose one of the main applications from the Home 
menu, which you reach by tapping the Home button. The Home menu looks like this: 

 

Navigating the Menus 

Note the following about navigating the menus: 

 At any level of the menus where there are more than four choices, four are displayed along 
with a scrollbar. You can scroll up and down by swiping your finger up and down. 

 A menu choice with a > sign near the right edge has submenus. Tapping the menu choice 
displays the submenus. The higher level menu slides to the left. 

 A menu choice without a > sign near the right edge does not have submenus. Choosing it 
causes something to happen, for example, Search displays a data-entry form on the main 
screen and a keyboard on the touch screen. On under Airplane mode turns airplane mode 
on. 

 When you are below the top level of the menus, the Back button < takes you back to the 
immediately higher menu. The lower level menu slides to the right, revealing the higher 
level menu. In some cases, this also changes what is on the main screen. 

Navigation on the Main Screen 
Some content on the main screen is navigable. That is, it has on-the-page navigation. These 
cases are: 

 Navigable lists, including ones that span more than one page. Examples include your Library 
and the list of collections in the Store. 

 Navigable parts of documents, including tables of contents in books, magazines, and 
newspapers. 

 Text content of books, magazines, and newspapers is navigable when creating highlights 
and notes. 



 

nook User Guide  39        

For the first two, use these controls: 

 
(Up): Navigate up in a navigable list on the main screen. 

 
(Down) Navigate down in a navigable list on the main screen. 

 
(Select) Select the indicated item in the list. 

Creating highlights and notes uses the D-pad control, which is explained below. 

Data Entry 
When you need to enter data, for example to register your nook or search, your nook 
displays a data entry form on the main screen and a keyboard on the touch screen. 

Use the keyboard to type in the form, and to submit what you typed. Here is some 
information about navigation in forms. More information about the keyboard is given below. 

Form Navigation 

→ (Right Arrow): Moves the cursor to the right in a text entry box on a form 

← (Left Arrow): Moves the cursor to the left in a text entry box on a form 

<x (Backspace): Deletes the character in front of the cursor 

↑ (Up Arrow): Moves the cursor from one line of a multi-line form to the line above 

↓ (Down Arrow): Moves the cursor from one line of a multi-line form to the line 
below 

Cancel Cancels data entry and returns you to the context in which data entry was begun 

Submit Submits the entered data 

Multi-page Form 

Navigation in a multi-page form is the same as for a single-page, multi-line form. Move between 
pages using > and < keys. Complete all pages of the form before submitting it, or an error will 
result. Submit the form by tapping the Submit key. 
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Keyboards and Typing 
When you choose a task that requires data entry, your nook displays a keyboard. There are 
actually four keyboards, shown here and described below. 

 

Uppercase A standard keyboard that displays the uppercase alphabet. Switch to this 
keyboard from the lowercase keyboard by tapping Aa. On any other keyboard, 
tap ABC and then Aa. 

Lowercase A standard keyboard that displays the lowercase alphabet. This is the keyboard 
that is displayed first. Switch to this keyboard from the uppercase keyboard by 
tapping Aa. Switch to it from other keyboards by tapping ABC. 
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Numbers 
and 
Symbols 

A keyboard that displays the numbers and some symbols. Switch to this 
keyboard from the lowercase or uppercase keyboard by tapping 123?. Switch 
to it from the Additional Symbols keyboard by tapping 123. 

Additional 
Symbols 

A keyboard that displays the remaining symbols. Switch to this keyboard from 
the lowercase or uppercase keyboard by tapping 123? and then #+=. From 
the Numbers and Symbols keyboard, tap #+=. 

D-pad 
The D-pad (directional pad) control is displayed when you add highlights or annotations. It lets 
you move the cursor in all four directions in the text, so you can choose start and end points. 

 

Browsing 
Browse content in your Library and the Store using navigation controls and the Next and 
Previous buttons. 

Searching 
You can search in your Library and in the Store. The procedure is the same: 

1 In the Library or Store, tap Search. Search is available from the top-level menus, as well as 
from some submenus. If you want to search, and search is not in the menu, use the Back 
button to move up a level. 

Your nook displays a form on the main screen and a keyboard on the touch screen. 

2 Type the word or words for which you want to search. This is not a phrase search. The 
search must match all of the words, but in any order and in any of the fields that are 
searched. 
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3 Your nook displays a list of results that match your search. If the list is longer than one 
page, it is paginated; you can navigate between pages with the Next and Previous buttons. 

The fields searched depend on the context, as follows: 

Store: Title, author, contributors, and publisher 

Library: Title, author, contributors, publisher, and category 

Sorting Lists 
In the Library, you can sort lists. You can sort by: 

 Most Recent (default): The list is sorted by how recently you have read the content. 
Content that you have not read is sorted by how recently it was downloaded. 

 Title:  The list is sorted by the item’s title. The sort is a “smart” one, discounting the 
leading words “A” and “The.” 

 Author: The list is sorted by the last name of the first author. 

 Most Relevant: This choice is only available after a search, and it is the only choice after a 
search. The list is sorted based on an algorithm that gives more importance to title and 
author matches, and that considers the numbers of matches in the fields searched. 

To sort a list: 

1 Tap Library on the Home menu. 

2 (Optional) Tap Show and choose one of the filtering options: All, Books, Magazines, or 
Newspapers. 

3 Tap Sort by and choose a sorting order: Most Recent, Title, or Author. 

Filtering Lists 
In the Library, you can filter lists my content type. (In the Store, you can browse by content 
type, but you cannot filter lists by content type.) 
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You can show: 

 All 

 Books 

 Magazines 

 Newspapers 

To filter a list: 

1 Tap Library on the Home menu. 

2 (Optional) Perform a search. 

3 Tap Show and choose one of the filtering options: All, Books, Magazines, or Newspapers. 

4 (Optional; if you did not perform a search) Tap Sort by and choose a sorting order: Most 
Recent, Title, or Author. 

Main Status Bar 
The main status bar is displayed at the top of the reading screen at all times except when you 
are reading. When you are reading, a reading status bar is displayed instead. 

       Battery charge levels when your nook is not charging 
(from low to full charge) 

      

Battery charge levels when your nook is charging (from 
low to high) 

     Cellular signal strength (from low to high) 

     Wi-Fi signal strength (from low to high) 

    (Animation) Synchronization or other communication 
with the data service is in progress. 
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Registering your nook 
Registration is associating your nook with a B&N account (an account on the BN.com 
website). You do this on your nook, not on the Barnes & Noble website. 

A specific nook can be associated with only one B&N account. More than one nook can be 
associated with the same B&N account. 

Account Creation 
Creating a B&N account precedes registration or is handled during the welcome-screen 
sequence on your nook. During the welcome, you are asked to choose an existing B&N 
account or to create one. 

Default Credit Card 

If you create an account online, specify a default credit card. It will be needed to register your 
nook. If you did not specify a default credit card during account creation, you must do so 
during nook registration. 

Pre-Registration 
If you purchased your nook online, you were signed in at the time, and you did not designate 
the purchase as a gift, then your nook has already been registered automatically. It is already 
associated with your B&N account. The same is true if someone else purchased the nook 
online, was signed in, and did not designate the nook as a gift—it will be associated with 
his/her account. 

If the account association is wrong, you can de-register and re-register the nook. 

When purchasing a nook, you can designate it as a gift (or not):  

 A nook that is not a gift is pre-registered (it is associated with your account).  

 A nook that is a gift is not pre-registered (it is not associated with your account).  
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You can also purchase nooks in selected B&N stores. These nooks are not pre-registered, but 
you can register your nook immediately after purchasing it. 

Manual Registration 
If your nook is not pre-registered, you will need to register it. Your nook knows whether this 
is necessary, and leads you through the appropriate welcome pages the first time you turn it 
on. 

 

If you cancel or otherwise do not complete registration from the welcome pages, 
you can register later from Settings > Device > Register. 

Two cases apply: 

 Specifying an existing B&N account 

 Creating a B&N account 

 
To register your nook, you must be in the United States in an area with AT&T 
cellular network coverage (affiliate networks and roaming don’t count) or in a Barnes 
& Noble Store in the United States. 

Specifying an Existing B&N Account 
If you already have a B&N account, specify the account information during registration. Your 
nook will be associated with your account. If your B&N account does not have a default credit 
card, you will have the opportunity to specify one from your nook while registering. You must 
specify a default credit card to register your nook. 

The information you need during registration is: 

 B&N account email address 

 B&N account password 

 Credit card information (only if there is no default credit card) 
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If your nook informs you that your account information is not valid, double check the 
information you entered. You might have mistyped something. 

Creating a B&N Account 

If you do not already have a B&N account, you can create one while registering your nook. 
Alternatively, you could cancel registration from your nook, create an account on the BN.com 
website, and then register your nook from the Settings menu. This section explains account 
creation when registering your nook. 

The information you will need during registration is: 

 Your email address (the email address you want to use for your B&N account) 

 First name 

 Last name 

 A password to use for your B&N account 

 A security question and answer. For example, “What was my first dog’s name?” and 
“Bowser.” 

 Credit card type 

 Credit card number 

 Billing address 

 Name on card 

 Expiration date 

 Security code 

Library Catalog Download and Sync 
Immediately after registration, your nook downloads a local copy of the catalog from your 
online digital library. It uses this catalog copy when searching your library. Your nook keeps the 
local catalog in sync with the online catalog. 
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Your nook does not assume that you want to download all of the content in your library to 
your nook. It downloads content when you ask it to, or when you ask to read it. 

An Unregistered nook 
Fewer features are supported on an unregistered nook than on a registered one. On an 
unregistered nook: 

 You can browse the Store, but not buy anything (including free eBooks and samples). If you 
try to buy something, you will be prompted to register. 

 You can read, but not bookmark, highlight, annotate, rate, or recommend. 

 You can manage personal files and listen to music and audiobooks. 

 You do not receive in-store special offers, and cannot read eContent for free in a retail 
store. 

Deregistering your nook 
You should not need to deregister your device. But there are some cases when you might 
want to: 

 You are giving your nook to a family member or friend, but you do not want that person to 
make purchases. 

 You plan to sell your device. 
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Personalizing your nook 
Your nook is yours, and you can personalize it. You can: 

 Choose among predefined touchscreen themes (color themes) for the touch screen 

 Choose among predefined wallpaper images, or supply your own. The wallpaper image is 
displayed on the reading screen when the Home menu is displayed. 

 Choose among predefined screensaver themes, or provide your own screensaver images. 
A screensaver is a single, static image displayed on the main screen when your nook is 
asleep. 

Touchscreen Theme 
Choose among predefined touchscreen themes (color themes) for the touch screen menus. 
To choose a touchscreen theme: 

1 Tap Settings on the Home menu. 

2 Tap Touchscreen theme. 

3 Tap the theme you want to use. Your nook changes the appearance of the touch screen to 
the chosen theme. 

Wallpaper 

 

To use your own wallpaper images, side-load them from your personal computer to 
the folder My Wallpapers. For more information, see “Folders and Files.” 

Choose among predefined wallpaper images, or choose one of your own images. To choose a 
wallpaper image: 

1 Tap Settings on the Home menu. 

2 Tap Wallpaper. 



 

nook User Guide  49        

3 Tap the wallpaper image you want to use. 

4 Tap the Home button to view the wallpaper. 

Screensavers 

 

To use your own screensaver images, side-load them from your personal computer 
to the folder My Screensavers. For more information, see “Folders and Files.” 

Choose among predefined screensaver themes for the reading screen. To choose a 
screensaver theme: 

1 Tap Settings on the Home menu. 

2 Tap Screensavers. 

3 Tap the screensaver you want to use. When your nook sleeps, you will see the first 
screensaver image in the theme. 

Settings 
You can configure settings to make your reading experience the best for you. Several of the 
key settings are explained here. For the full list, see the chapter “Settings.” 

 Font type: You can choose between the default serif font and a sans serif font. 

 Font size: You can choose among five font sizes: tiny, small, medium (the default), large, 
and huge. 

 Touchscreen timeout: Time from last touch screen activity until touch screen backlight is 
turned off. You can choose among 10, 30 (default), and 60 seconds. 

 Sleep timer: Time from last activity (touch screen or button presses) until the nook sleeps. 
During sleep, a screensaver picture is displayed on the main screen. The touch screen will 
already be unlit. You can choose among 2, 5 (default), 10, 15, and 20 minutes. 

 Name: You can name your nook. Tap Settings > Device > Device profile and specify your 
name and your nook’s name. 
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The Daily 
The Daily is a bulletin-board style message center. You automatically receive daily editorial 
content and notices. 

To visit The Daily, tap the Daily on the Home menu. 

Editorial Content 
The Daily is where you receive: 

 Grin & Tonic is a short, humorous piece of writing that builds on current events. It can 
also contain cartoons.  

 Day Book presents a digest of B&N review content and an article of the day. It can also 
include this day in literature. Did you know that on December 27th, 1831 Charles Darwin 
set sail on H.M.S. Beagle, a journey that he would record in The Voyage of the Beagle, and 
that would provide the foundation for his writings about evolution? Writing of his stay in 
the Galapagos Islands, Darwin remarks “I had not yet noticed by far the most remarkable 
feature in the natural history of this archipelago; it is that the different islands to a 
considerable extent are inhabited by a different set of beings.” He goes on to write “I never 
dreamed that islands, about 50 or 60 miles apart, and most of them in sight of each other, 
formed of precisely the same rocks, placed under a quite similar climate, rising to a nearly 
equal height, would have been differently tenanted; but we shall soon see that this is the 
case.”  

Notices 
Notices include: 

 Notices about promotions and special offers 

 Notices about in-store events for the store nearest you. If you specified a favorite store in 
your community profile on the B&N website, that store is used. If not, the store chosen is 
based on your zip code. 
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 Notices about your content. The Daily is where you find out about eBooks and issues of 
you subscriptions that have been delivered to your online digital library. You also receive  

 Notices about the availability of new eBooks and ePeriodical issues in your online digital 
library. The number of new items is displayed on the Home screen icon for The Daily. 

 Notices about the expiration of the trial period for subscriptions 

 Notices about offers from friends to lend you books 

 Notices regarding your nook or account 

 Notices about device software updates that have been performed, that require Wi-Fi, or 
that require side loading  
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Store 
Your nook’s wireless connectivity lets you shop for content from your nook. There is no need 
to visit a website. What you buy is delivered to your online digital library immediately and 
downloaded to your nook within about a minute. For a subscription, the current issue is 
delivered and downloaded. 

To enter the Store on your eReader, choose Store from the main menu. 

You can browse and search in the Store on an unregistered nook. You just can’t buy anything. 
If you try to buy something from an unregistered nook, your nook will prompt you to register. 

Simple Process 
Making purchases in the store is simple. The process described here applies to eBooks and 
ePeriodicals, to content that costs money and that is free. 

To make a purchase: 

1 Touch Store on the Home menu. 

2 Browse to or search for content: 

Use the View and Browse menus and navigation keys (Up, Down, and Select) to browse 
collections or content types. 

Or use the Search menu to search for what you want. Details on browsing and searching 
follow this section. 

3 Touch Select to select the item you want to buy. Your nook displays a detail page for the 
item that includes pricing information. 

4 Touch Buy. 

5 Confirm your purchase, and you are done. The item you bought is delivered to your online 
digital library and downloaded to your nook. 
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Storefront 
The first page of the store is the storefront. It is a navigable page with three parts: 

 Collections contains lists of content, such as Bestsellers, New Releases, and Coming Soon. 

 Browse allows you to browse items of each content type—books, magazines, and 
newspapers. 

 A merchandising area at the bottom of the main screen displays B&N corporate 
promotions such as special offers. When you are in a Barnes & Noble retail store, the 
merchandising area also displays in-store special offers. The merchandising area can span 
several pages. More information about that can be found below. 

Browsing the Store 
You can browse the store to look for content. In any list of content, you can also sort and filter 
the list, to make it easier to find what you are looking for. 

Selecting Content to Browse 

To select an area to browse, navigate up and down the storefront with the Up and Down 
buttons. You can navigate through the collections, content types, and the merchandising area. 
When you reach the area you want to browse, tap Select. 

Searching the Store  
You can search the store on your nook for digital content that can be downloaded to your 
nook. You cannot search for printed books, nooks, or accessories. For those, visit the B&N 
website or a B&N store.  

Search from the Storefront searches the entire store. When browsing a collection or content 
type, you have the option of searching within that category (Search <category>) or of 
searching the entire store (Search All).  

When you search for eBooks, the results include any B&N books and Google books that 
match the search criteria. 
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To search: 

1 In the Store, tap Search in the menus. 

2 Use the keyboard to enter one or more search terms in the form. 

3 Tap submit. Your nook performs the search. 

The search looks for items with all of the terms in any of the following metadata fields: 

 Title  

 Contributors  

 Author  

 Publisher  

 Category 

Result Lists 
When a search completes, your nook displays the results that matched your search criteria. If 
no results matched, a message indicates that. 

Navigate up and down the search results list with the Up and Down keys. Turn pages in a 
multipage list using the Next and Previous buttons. Select an item with the Select key. 

Orders 
From your nook you can make the following kinds of orders: 

 eBook ePeriodical single issue ePeriodical subscription 

Purchase    

Pre-order    

Download free item    
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Download free sample    

Free trial period    

Read in B&N retail store    

 

Ordering from your nook 
Note the following about ordering from your nook: 

 Your nook must be registered. If you try to order content from an unregistered nook, you 
will be asked to register. 

 Only customers with billing addresses in the United States and Canada can purchase 
eContent. It cannot be purchased by customers with International, U.S. Territory, or 
APO/FPO (Army Post Office / Fleet Post Office) billing addresses.  

 You can pay for purchases made from your nook with your default credit card, or with a 
gift card balance and your default credit card if required. If you indicate you want to use a 
gift card balance, it is used first and the remainder (if any) goes on the credit card.  

 If your default credit card has expired when you try to order an item (including a free 
eBook), you will be asked to update the expiration date.  

 By default, you will need to confirm orders you make from your nook (by replying Yes to a 
pop-up prompt). You can turn off these confirmation prompts in Settings. If you do, 
remember that when you tap Buy, you have bought it.  

 Have you ever bought a book twice? I have. Your nook will prevent you from being so 
foolish. If you try to order content that you have previously ordered, your nook will inform 
you that you already have the content in your online digital library. If the content is 
archived, your nook will tell you so. 

Pre-Ordering eBooks 

You can pre-order eBooks that are not currently available, but that will be available soon. 
When the eBook becomes available, it is delivered to your online digital library, you are 
charged for it, and you receive a notice in The Daily that it is available. 
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Ordering ePeriodicals 

For ePeriodicals, you can purchase a single issue or a subscription: 

 When you purchase a single issue, the current issue is delivered and downloaded to your 
nook. 

 When you purchase a subscription, you begin a 14-day free trial period. The current issue 
is delivered and downloaded to your nook. 

 You cannot pre-order ePeriodical issues or subscriptions. 

Downloading Free eBooks 

This section applies to downloading free eBooks when not in a B&N retail store. See the 
chapter “In-Store Experience” for information about reading in a B&N store. 

When you view item details for an eBook and the eBook is free, you “purchase” it just as you 
would for an eBook that costs something. The only difference is that there is no charge. 

Downloading Free Samples 

Some eBooks have a free sample you can download. The free sample is typically the first part 
of the book. 

If there is a free sample for a book, Download Free Sample is a choice in the menus. 

If you already have a free sample or own an eBook, including when you have loaned it to a 
friend, you cannot download the free sample.  

Free Trials for ePeriodicals 

When you purchase a subscription to an ePeriodical or blog for the first time, you 
automatically get a 14-day free trial.  

During the free trial period, your credit card (or gift card) is not charged. During the free trial 
period, you can cancel your subscription and you will not be charged. If you cancel the 
subscription, you cannot restart the free trial (but you can purchase the subscription).  

If you do not cancel your subscription during the free trial period, you will continue to receive 
issues and you will be charged for the subscription. 
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Content Delivery 
eBooks and just-purchased issues of ePeriodicals and blogs are delivered to your online digital 
library immediately. 

Subsequent issues of ePeriodicals are delivered to your online digital library once a day 
between 2 AM and 5 AM local time, approximately. 

Pre-ordered eBooks are visible in your on-line digital library but are not available for 
download.  

Late Deliveries 

Has content you expected not arrived? Perhaps it is late. We hope content is never late, but 
we also live in the real world. If content has not arrived, other possible explanations include:  

 Your nook was off when the delivery attempt was made. 

 A content-delivery server went down. 

When B&N is able to deliver the content, we will. And you will receive a notification about its 
delivery. 

New Content 

For new content, including purchases and current issues of subscriptions: 

1 The content is delivered to your online digital library. 

2 For 48 hours, new content is flagged in the Library with a New indicator. 

3 A notification about the content delivery is sent to your nook. You can view it in The Daily. 

4 Some content is automatically downloaded to your nook. For other content, you must 
request a download. 
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Downloading Content 
To download content from your online digital library: 

 Your nook must be registered.  

 Your nook must have connectivity, either to the cellular network or a Wi-Fi hotspot.  

When you download DRM-protected content, it is encrypted using your first and last name 
and default credit card number. To open it, you must enter your first and last name and default 
credit card number.  

Automatic Downloads 

eBooks, just-purchased issues of ePeriodicals, and current issues of just-purchased 
subscriptions are downloaded to your nook automatically after delivery to your online digital 
library. The content should be available on your nook a minute or two after you purchase it. 

Manual Downloads 

Issues of ePeriodicals after the first one are not downloaded automatically to your nook. You 
receive notifications in The Daily and can request that the items are downloaded. 

If you have deleted B&N content from your nook, you can request that it be downloaded 
again. You can download content from your online digital library to your nook an unlimited 
number of times. 

 

If you cannot download recently purchased content, some problem might have 
occurred during the purchase process. Check your notifications to see if there is a 
problem. 

If you download content again, and your default credit card information has changed, enter the 
current information to unlock the content.  
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My Wish List 
My Wish List is a list of books, magazines, and newspapers, you would like to read. When a 
friend recommends a book, add it to your wish list. While searching for the book you are 
buying today, you found others that intrigue you? Add them to your wish list. You can revisit 
them later, and decide whether you want to buy them. Are you over budget for book 
purchases this month? Well, there is always next month, or your birthday. Add them to your 
wish list. 

View My Wish List 

To view your wish list, tap My Wish List in the top-level menu for the Store. 

Add an Item to My Wish List 

To add an item to your wish list: 

1 In the Store, navigate to the item you want to add to your wish list and tap Select. 

2 Tap Add to Wish List.  

Remove an Item from My Wish List 

To remove an item from your wish list: 

1 In the Store, navigate to the item you want to remove from your wish list and tap Select. 

2 Tap Remove from Wish List.  

Buy an Item on My Wish List 

To buy an item on your wish list: 

1 In the Store, tap My Wish List to view your wish list. 

2 Using the Up and Down keys, navigate to the item you want to buy and tap Select. Your 
nook displays details for the item. 

3 Tap Buy. 
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In-Store Experience 
Special things are in store for you when you visit a B&N retail store with your nook: 

 You receive information on local events, unique content, special offers, and coupons. 

 You can read any eBook for free. Read your favorite eBook while enjoying a beverage or 
food from the B&N/Starbucks cafe. 

Your B&N retail store also has nooks, nook accessories, and paperback and hardback books, 
magazines, and newspapers. 

Welcome 
When you enter a B&N retail store, your nook automatically connects to a Barnes & Noble 
Wi-Fi hotspot so you can access the eBookstore. It also displays a welcome message that 
alerts you to in-store content. 

Storefront 
In a B&N retail store:   

 Special In-Store Offers is added to the navigation area. 

 The store merchandising area is updated to include in-store offers and announcements. 

Reading 
You can read any eBook and most current issues of ePeriodicals in a B&N retail store free of 
charge, with three additional conditions:  

 You can read a specific title for a maximum of one hour every 24 hours. 

 The system throttles the rate of content delivery to approximate a fast reading rate. 

 There is also a maximum amount of content that can be read in a one-hour period. 
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Several restrictions apply to reading free content: 

 You cannot save or archive free content. At the end of the hour or when you leave the 
store, it will no longer be available. You can read it another time (after 24 hours have 
passed). 

 You cannot bookmark, highlight, or annotate free content. 

 You cannot change the font or text size while reading free content. The font and text size 
used are based on the settings in use when you began reading. 

Procedure 

To read in a store: 

1 Touch Store on the Home menu. 

2 Browse to or search for content: 

Use the View and Browse menus and navigation keys (Up, Down, and Select) to browse 
collections or content types. 

Or use the Search menu to search for what you want. Details on browsing and searching 
follow this section. 

3 Open the item you want to read in the Reader. Do one of the following. 

 Double-tap Select. 

 Tap Select to select the item you want to read. Your nook displays a detail page for the 
item. Tap Read In Store. 

Your nook displays the content in the Reader. 
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Library 
Two content repositories are accessed from the Library icon on the Home menu: 

 My Library provides access to your B&N content. You have a unified view of the B&N 
content on your nook and in your online digital library. 

 My Documents provides access to your personal (non-B&N) content. 

My Library 
My Library stores your B&N content: eBooks; issues of eMagazines and eNewspapers; and 
subscriptions to eMagazines and eNewspapers. You select content to read from your library. 
You can also lend and rate content from your library. 

B&N content is in one of two states: 

 Local and online: This content has been purchased, delivered to your online digital library, 
and downloaded to your nook. 

 Online only: This content has not yet been downloaded to your nook (through automatic 
synchronization or request), or has been but has subsequently been archived, which 
removes the copy from your nook. 

By default, My Library on your nook shows you all B&N content in both your online digital 
library and on your nook. You can choose to hide content that is only in the online digital 
library. 

Previously Purchased Content 
If you purchased content before registering your nook, this is what happens with it: 

 eBooks purchased from B&N.com are automatically delivered to your online digital library 
a short time after you register your nook. They are not automatically downloaded to your 
nook. You can download them manually from the Library, or just leave them in the online 
digital library. They will be there to download in the future. 
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 eBooks not purchased from B&N.com, including those from Fictionwise and eReader.com, 
are not delivered to your online digital library or downloaded to your nook. You can side-
load these eBooks from your personal computer to your nook, and manage them as 
personal files. 

Indicators 
Content in My Library can have the following indicators displayed: 

 An audio file (MP3 format). This indicator is displayed for music files. 

 An audiobook file (MP3 format) 

 An eBook that is borrowed from a friend 

 An eBook in ePub format 

 Content that has been delivered to your online digital library within the 
previous 48 hours, and that you have not opened to read 

 An eBook that you have loaned to a friend 

 An eBook in PDF format 

 An eBook sample 

Browsing 
The content in your library is displayed as a paginated list: 

 Browse up and down the list using the Up and Down keys. 

 Move from page to page using the Next and Previous buttons. 

Sorting Your Library  
You can sort the eBooks in your library by:  

 Date added (default)  

 Title  
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 Author  

 Customer rating (highest rating to lowest, then unrated)  

You can sort ePeriodicals in your library by:  

 Issue date (default)  

 Title  

 Publisher  

 Customer rating (highest rating to lowest, then unrated)  

Filtering Items 
You can filter the items presented, to view only each of the following: 

 eBooks 

 eNewspapers 

 eMagazines 

 Free samples  

You can also choose to view only items that are in both the online digital library and local 
library or items that are only in the online digital library (new and archived items). 

In your local library, you can also filter your view to show only:  

 Music 

 Audiobooks 

 Documents  
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Archiving B&N Content 
B&N content can be: 

 In your online digital library but not on your nook. The content has been delivered to the 
online digital library but not downloaded to your nook. 

 In your online digital library and on your nook. This is the situation following an automatic 
or manual download of content to your nook. You can download content to multiple 
devices that are associated with your account. 

 Archived. This content was previously both in the online digital library and on your nook, 
and has now been deleted from your nook (and other devices associated with your 
account) and flagged as Not on Device in your Library. 

Archiving content does three things: 

 It deletes the content from your nook. The content is retained in your online digital library. 
You still own the content and retain the rights to it. 

 It flags the content with the Not on Device indicator in your Library. 

 When other devices associated with your account synchronize with the online digital 
library, they also delete the content from the devices. 

 
Archiving an issue of a periodical does not save the issue from automatic deletion. 
To save an issue, you must use Save Issue. 

Archiving is a manual process. There is no automatic archiving. 

Free samples and in-store content cannot be archived. 

Unarchiving B&N Content 
The reverse of the archiving process is accomplished by downloading content. When you 
download archived content to your nook: 

 The content is downloaded to your nook. 
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 The Not on Device indicator is removed from the content in your Library. 

If you want the content on multiple devices associated with your account, you must download 
it to each. 

Showing and Hiding Archived Content 
When you browse your Library, you can: 

 Show Archived Items: Show content that is on your nook and in your online digital library, 
as well as content that is only in your online digital library. 

 Hide Archived Items: Only show content that is both on your nook and in your online 
digital library. 

Show Archived Items and Hide Archived items are menu choices in the Library. 

Back Issues of Periodicals 
When you subscribe to a periodical, new issues are delivered automatically to your online 
digital library. You can have your nook automatically download them, or you can manually 
download them. 

Your online digital library keeps up to seven issues of a periodical and automatically deletes 
older issues unless you save them. 

You can save any issue that you want to save, and any number of issues. You can save issues 
that are only in your online digital library, or that are in your online digital library and on your 
nook. 

If your online digital library contains seven issues of an ePeriodical that are not flagged as Saved 
(you have not done Save Issue for them), and a new issue is delivered, then the oldest issue 
not flagged as Saved is deleted. 

If the issue is present on your nook, it is deleted from your nook too the next time your nook 
synchronizes. 
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Issues that are not flagged as Saved are deleted automatically whether or not they 
have been read. 

Deleting B&N Content 
We recommend that you not delete B&N content. Instead, archive it, which removes the 
content from your nook (and other devices associated with your account) and flags the 
content as archived in your Library. 

There is no way to just delete content from your nook. To free up space on your nook, 
archive the content, which deletes it from your nook, deletes it from other devices associated 
with the account, and flags the item as archived in the Library. 

If you really do want to delete B&N content, you can do so from your account (the one 
associated with your nook) on the B&N.com website. 

When you delete content from your online digital library using the B&N.com website: 

 It is deleted permanently from your online digital library. 

 It is deleted permanently from your nook and from all other devices associated with the 
account. 

 Even if you have a copy of the content, you cannot put it back in your Library (to do that, 
you have to buy it again). If you did save a copy, you could side-load it from a personal 
computer and manage it as a personal file. 

 
If you delete content from your online digital library, you cannot get it back, even by 
calling customer service. By deleting the content, you no longer own it, so the only 
option is to re-purchase it. Think of it in the same terms as throwing away a book. 

Item Details 
You can view details about the items in your library. 
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eBooks 

In your library, when you navigate to and select an eBook, your nook displays a page with 
detailed information about the item. 

From that page, you can: 

 Tap View > Overview to view a synopsis of the eBook, as well as information about the 
author if available. If the overview exceeds a page in length, use the Next and Previous 
buttons to navigate. 

 Tap View > Book Cover to view a large image of the book cover on the reading screen. 

 Tap View > Full Book Details to view all of the data about the eBook, for example, the 
ISBN, publisher, number of pages, etc. 

 Tap View > More Information to view additional information about the eBook from the 
B&N website. 

eMagazines and eNewspapers 

In your library, when you navigate to and select an eMagazine issue or eNewspaper issue, your 
nook displays a page with detailed information about the item. 

From that page, you can view more information about the item by tapping View > Overview. 

My Documents 
Accessible from the Library icon on the Home menu, My Documents is a view of your 
personal documents, that is, files such as music files and non-B&N eContent. 

When you place personal files on your nook, you can organize the files into folders of your 
choosing. Any hierarchy is fine. When viewed from your personal computer, the files retain 
this organization. Your nook does not move them. 

My Documents is not a view of the files and folders, but of information about the files. It is a 
flat view, a list. The hierarchy is not reflected in the list.  

You can browse, filter, sort, and search the list of documents. 
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Indicators 

Personal content in My Documents can have the following indicators displayed: 

 An audio file (MP3 format). In My Documents, there is no distinction 
between music files and audiobooks. 

 An audiobook file (MP3 format) 

 An eBook in ePub format 

 An eBook in PDF format 
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Reading 
This section explains the features available when reading an eBook or ePeriodical on the main 
screen. 

Orientation 
The reading orientation on the main screen is vertical (often called portrait orientation). You 
hold the reader in the normal upright position, and text is displayed in lines across the main 
screen. 

There is one exception to this. In a PDF, one or more pages (and possibly an entire document) 
can have pages that have been rotated 90, 180, or 270 degrees. In this case, pages that are 
rotated in the PDF are displayed rotated on your nook. 

Ergonomics 
Ergonomics is a big word for the study of how to make things comfortable and easy to use, 
and to reduce injuries. The nook was designed with you and reading in mind. 

The best advice we can give is to find what is comfortable for you. 

Reading must be a comfortable activity. With the nook, it will be. If one reading position is not 
comfortable, try a different one. Balance the nook differently. Place your hands differently. 
Press the Next and Previous buttons differently. We are quite sure that some of the 
ergonomic suggestions that follow will work for you. 

Holding your nook 

Hold your nook so it is balanced well and does not feel top-heavy. You can change the balance 
of the nook by moving your hands further up or holding your nook more in a more vertical 
position. You probably will want to hold it with both hands. If you hold it with one hand, rest 
that hand or arm on something, for example, your leg.  
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Next and Previous Buttons 

Position the hand with which you turn pages so it is not a strain to reach the one of the Next 
buttons. 

Keyboard 

With your nook on a flat surface, you can type on the keyboard is an approximation of 
standard-keyboard typing (or for that matter “hunt and peck” typing). 

An alternative is to use a mobile-device approach to typing by holding the device on each side 
near the bottom and using your thumbs. To do this, you might want to rest the top of your 
nook against the edge of a table or against your knee. 

Eyeglasses 

If you use eyeglasses to read paper books, you should wear them to read your nook. 

Reading Distance 

The optimal reading distance varies depending on your eyes, but somewhere between 13 and 
16 inches is probably ideal. You can change the text size on your nook so that you can read at 
an optimal distance. 

Light 

Your nook’s reading screen is like a piece of paper. You need light to read it. Make sure you 
have enough light, and position the nook relative to the lights so that there are no direct 
reflections. 

Take Breaks 

As you would do with paper books when reading, take breaks to reduce eye strain. 

Text Font and Size 
Text in an eBook in EPUB or PDB format is displayed in a single font. You can choose among 
two fonts in the Settings menus. 

When displayed, the text of eContent in EPUB, PDB, and reflowable PDF documents is in one 
of five sizes. In the Settings, the sizes are identified as Tiny, Small, Medium, Large, and Huge. 
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Other text, for example, chapter and section headings, is also sized proportionally based on 
the Settings value. 

Beginning Reading 
When you select content to read, you are taken to: 

 The first page if you have not read this content before 

 The most recently read page if you have read this content before 

Unlocking DRM Content 
If the content is DRM content and an unlock code has not been previously supplied on this 
nook, you will be prompted to enter the unlock code—your credit card number (or the credit 
card number of the person who purchased the content, if that was someone else). Take the 
same precautions you normally would with your credit card number. You only need to enter 
the unlock code the first time you open the eBook. 

Reading Status Bar 
When you are reading, a reading status bar is displayed instead of the main status bar. It 
contains: 

Title Title of what you are reading 

 A bookmark in your eBook 

# | # (for example 24 | 543) Current page number (in bold) and the total number of 
pages 

This is an example: 
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Navigating 
You can navigate from page to page by pressing the Next and Previous buttons. 

You can also go to these locations in a book using the menus: 

 Cover 

 Table of Contents (if present) 

 Chapters 

 Pages 

 Furthest read page 

 Bookmarks 

 Highlights and notes 

Looking up Words 
Your nook has Merriam-Webster’s Collegiate Dictionary installed in your Library. It is 
permanent (a Reference item) and is visible when you view all items or eBooks. 

You can look up words while reading. You can also open the dictionary from your Library and 
look up words. 

You can look up words, not phrases. However, the dictionary does define some phrases. For 
example, if you look up "carry," the phrases "carry a torch," "carry the ball," and "carry the day" 
are also defined.  

To look up a word:  

1 Select the word you want to look up using the D-pad controller. Pressing 
Up/Down/Right/Left on the D-pad controller will move the selection from word to word 
indicating the currently selected word.  
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2 Choose Look Up displays the definition in a dialog panel overlaying the reading content. A 
definition can be more than one page in length. Move between pages using the Next and 
Previous buttons. 
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Lending eBooks 
Share your favorite eBooks with friends, family members, or with members of your book club, 
by lending any of your eBooks one time for up to 14 days.   

Have you found an eBook that you know your friend Mary would love to read? And your 
friend Steve found a must-read book for you? With your nook, you can lend eBooks to friends. 
And friends can lend eBooks to you. 

Restrictions 
There are some restrictions: 

 You can only lend B&N content from a registered nook to users of other registered nooks 
(or other registered B&N eReader devices). You can send a loan offer to any email 
address, but to accept the offer, the other person must have an email address associated 
with a B&N account. 

 You can only lend an eBook one time. 

 A loan is for a maximum of 14 calendar days, counting the day on which the lending offer is 
received. A loaned eBook is automatically returned at the beginning of the 15th calendar 
day (if the borrower has not returned it more quickly). 

 When you lend an eBook, you temporarily lend the digital rights to the eBook. While the 
book is on loan, you cannot access it. When the book is returned, you get the digital rights 
back, and can access the book again. 

 You cannot lend a book that has been loaned to you. 

 You cannot save a copy of a book that has been loaned to you to the microSD card. 

 You cannot delete a book that has been loaned to you. 

Lending an eBook 
You lend an eBook to a friend with an email address. You can choose one of the friends you 
have previously defined, or you can specify a new email address. 
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To lend an eBook: 

1 Choose Home > Library. 

2 Browse or search for the eBook you want to lend. 

3 Using the Up and Down arrows, move the selection marker on the reading screen to the 
item.  

4 Tap Lend and do one of the following: 

 Choose an already defined friend. Tap the menu with the friend’s name. 

 Define a friend and then choose that friend. Tap Manage Friends and then Add New. 
When you have defined the friend, us the Back key to return to the Recommend 
menu, and choose the friend. 

 Tap Enter Email and enter an email address. In this case, the lending offer is sent to 
your friend, but your friend’s email address is not added to your list of friends. 

On Loan Indicator 

While a lending offer is pending, you can continue to read the book. It is only when your friend 
accepts the loan that you lose access to it. When that happens, the book information is grayed 
out in your Library. An On Loan indicator is displayed: 

 

Borrowing an eBook on a nook 

 

This section is written from the viewpoint of you receiving a notice about a lending 
offer. It applies equally to others with registered nooks receiving lending offers. 

If a friend offers to lend you a book, you receive a lending offer notice among the notifications 
in The Daily. You have seven calendar days to accept or decline the offer. At the beginning of 
the eighth calendar day, the lending offer expires. 

Notice that Lending Offer Will Expire Soon 

If you receive a lending offer notice and do not act on it, then on the beginning of the seventh 
day, you receive a warning that the lending offer will expire today. 
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When viewing this notice, Accept and Decline are choices in the menus. You do not need to 
navigate to the original lending offer notice. 

Expiration of a Lending Offer 

If you receive a lending offer and neither accept nor decline the offer before the end of the 
seventh calendar day, the offer expires. The notice remains in The Daily, but it cannot be 
accepted or declined. You receive an additional notice informing you that the lending offer has 
expired. 

Accepting a Lending Offer 

To accept the lending offer: 

1 In The Daily, navigate to the lending notice and tap Select. 

2 Tap Accept. Your nook displays a pop-up message that tells you the eBook has been 
delivered to your online digital library and downloaded to your nook. 

Rejecting a Lending Offer 

To reject a lending offer: 

1 In The Daily, navigate to the lending notice and tap Select. 

2 Tap Decline. 

Delivery and Download 

When you accept a lending offer, the eBook is delivered to your online digital library and 
downloaded to your nook. 

Borrowed Indicator 

When someone has loaned you a book, it is in your library. It has a Borrowed indicator next 
to it: 
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Option to Buy the eBook 

You have the option to buy your own copy of a book that someone has loaned to you. You 
can buy the book from the menus while reading it or from your library. 

To buy a book while reading it: 

1 Tap Buy. 

To buy a book loaned to you from your library: 

1 Navigate to the eBook in your library and tap select to view details about the eBook. 

2 Tap Buy. 

Returning the eBook 

An eBook that is loaned to you is returned automatically after 14 days (at the beginning of the 
15th calendar day). But you can return the book sooner if you finish reading it sooner. 
Remember that the person who loaned it to you cannot read it while it is loaned to you. To 
return a book: 

1 In the Library, navigate to the book that you want to return and tap Select to view item 
details. 

2 Tap Return Book. 



 

nook User Guide  79        

 

 

Bookmarks, Highlights, and Notes 
You can bookmark, highlight, and annotate the eBooks and ePeriodicals that you read. 
Bookmark pages you might want to refer back to in the future. Highlight interesting passages. 
Add your own notes. 

Your annotations, highlights, and bookmarks remain in the eBook or ePeriodical (or you can 
delete them). 

Bookmarks 
Bookmark pages with key passages in an eBook to make them easier to find. A page with a 

bookmark has this symbol in the reading header: . For example: 

 

Highlights 
Highlight text to draw your attention to it. 

I never dreamed that islands, about 50 or 60 miles apart, and most of them in 
sight of each other, formed of precisely the same rocks, placed under a quite 
similar climate, rising to a nearly equal height, would have been differently 
tenanted; but we shall soon see that this is the case. 

Notes 
Take notes in your eBook. Notes are indicated by a small number in the margin: 

1 I never dreamed that islands, about 50 or 60 miles apart, and most of them in 
sight of each other, formed of precisely the same rocks, placed under a quite 
similar climate, rising to a nearly equal height, would have been differently 
tenanted; but we shall soon see that this is the case. 
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Rating and Recommending 
Your opinion of what you read matters. Ratings, reviews, and recommendations of books by 
others guide your choices toward eBooks and ePeriodicals that you are more likely to enjoy. 
Your ratings, reviews, and recommendations help guide other readers. 

On your nook, you can: 

 View reader ratings of books in the store and in your library 

 Rate eBooks and ePeriodicals in your library 

 Recommend eBooks and ePeriodicals in your library to friends 

 

You can rate and review B&N content in your library. You cannot rate and review 
side-loaded content. 

On the B&N website, you can: 

 View reader ratings of books in the store and in your library 

 Rate eBooks in the store and in your library 

 View reviews of eBooks in the store 

 Write reviews of eBooks in the store or in your library 

Rating 
You can rate eBooks and ePeriodicals that you own. You do so from the detail page for an 
item in your library. To rate an item: 

1 Tap Home > Menu. 

2 Browse or search for the item you want to rate. 

3 Using the Up and Down arrows, move the selection marker on the reading screen to the 
item.  
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4 Tap Select. Your nook displays a page of details for the item. 

5 Tap the menu item that consists of stars. Your nook displays the ratings slider. 

6 Tap the location of your rating or slide your finger to that position and then raise your 
finger. 

Recommending 
Reading a good book? You can recommend the book to friends from your nook. 

Note: Your friends do not need to have Barnes & Noble accounts to receive 
recommendations. 

To recommend an eBook or ePeriodical to a friend: 

1 Tap Home > Menu. 

2 Browse or search for the item you want to recommend. 

3 Using the Up and Down arrows, move the selection marker on the reading screen to the 
item.  

4 Tap Select. Your nook displays a page of details for the item. 

5 Tap Recommend and do one of the following: 

 Choose an already defined friend. Tap the menu with the friend’s name. 

 Define a friend and then choose that friend. Tap Manage Friends and then Add New. 
When you have defined the friend, us the Back key to return to the Recommend 
menu, and choose the friend. 

 Tap Enter Email and enter an email address. In this case, the lending offer is sent to 
your friend, but your friend’s email address is not added to your list of friends. 

Your friend will receive an email with your recommendation. The email contains a link to the 
item on the Barnes & Noble.com website. The recommendation does not expire. 
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Folders and Files 
You can manage files on your nook from a personal computer, using the provided USB cable 
to connect the eReader to your computer. This lets you: 

 Obtain content from the Internet and place it on your eReader 

 Back up files 

Connecting the Device to Your Computer 
You connect your nook to your personal computer with the provided USB cable, as shown. If 
your nook is sleeping when you plug it in, it wakes up. If it is off, it turns on. 

 

The USB interface uses USB 1.1, which has a maximum data transfer rate of 12 Mbps. 

With the nook awake, when you connect your nook to a personal computer, you are asked if 
you want to connect to your personal computer. To manage files and folders, answer 
Connect. 

Mass Storage Mode 
Mass storage mode lets you manage B&N and personal content on the internal flash memory 
and on the supplemental microSD or microSDHC card, if there is one. 

You cannot simultaneously manage files through USB and use your nook, so the device is 
locked. 



 

nook User Guide  83        

Managing Folders 
Your nook uses the following top-level folders on both the internal memory and a 
supplemental microSD card to locate specific kinds of content: 

 My Documents: Documents that your nook can read (eContent in ePub, PDB, and PDF 
formats) 

 My Music: Audio files (MP3) 

 My Audiobooks: Audiobook files (MP3) 

 My Screensavers: Screensaver images (JPG, GIF, PNG, or BMP) 

 My Wallpaper: Wallpaper images (JPG, GIF, PNG, or BMP) 

You cannot delete these directories. 

You can create subfolders of these folders if you like, to organize your files. When your nook 
presents the files to you, it flattens the hierarchy and presents a list. 

Use the file manager on your personal computer to manage folders. 

 
If you put personal files in folders under the correct top-level folders, then the 
content will be found. If you put personal files anywhere else, they will be on the 
nook, but your nook will not find them. 

Managing Files 
Use the file manager on your personal computer to manage personal files on your nook. 

Keep a Copy of Your Personal Files 

Electronic storage media sometimes fail to preserve your files. They encounter magnetic fields 
that are too feisty, get dropped from boats into lakes, and get stolen. It is a good idea to 
periodically back up the personal files on your nook to your computer. 
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Regarding your B&N content in My Library, if you lose copies on your nook, you can 
retrieve them from your online digital library. You can also back them up yourself on 
your personal computer. 
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Platforms 
Read across platforms. Start the day reading your eBook on your nook, switch to a 
Smartphone while commuting (not while driving), to your personal computer during your 
lunch break, and back to your nook when you get home. The B&N eReader applications on 
your nook and the other platforms keep track, and return you to the page where you left off 
reading. 
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Software Updates 

 

If your nook is not registered, you will not receive notifications about software 
updates. You can download software updates from the BN.com Support site. 

Each time your registered nook synchronizes, it checks to determine whether the software it is 
running is the latest available. 

Software updates fix problems with the software. They also contain new features. Updates are 
required. 

Prompt and Download 
Your nook prompts you when a software update is available. It handles the download as 
follows: 

 If the update is small, your nook downloads it immediately over the AT&T cellular data 
network, or using a Wi-Fi hotspot if one is available. 

 If the update is large, your nook can usually download it using a Wi-Fi hotspot, for 
example, in a Barnes & Noble retail store. If a Wi-Fi hotspot is available, your nook 
downloads the update. If no Wi-Fi hotspot is available, your nook displays information 
about how to connect to a Wi-Fi hotspot. Obtaining the update from the BN.com support 
site and side-loading it through USB is also an option. 

 For some updates, side-loading the update from a personal computer through USB is 
required. These updates are made available on the Support section of the BN.com 
website. 

Prior to downloading the software update, your nook determines whether the cellular or Wi-
Fi signal strength is sufficient for the download. 

If a download does not complete, for example, because the wireless connection is lost, your 
nook attempts to continue the download the next time it is powered on. 
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After your nook downloads the software, it informs you that it will install the update the next 
time it sleeps. 

Installation 
Your nook installs the software update the first time to sleeps after downloading the update. If 
the installation fails for some reason, for example, if the battery charge is critically low, your 
nook will try the update again the next time it is powered on. 

Restart 
Following installation, your nook restarts. When it restarts, it: 

 Saves any unsaved state information such as reading position and notes 

 Closes the audio player, if it is running 

 Displays The Daily when it reboots. The Daily will have a notification that the update has 
completed. 

If you were reading when the update occurred, you will be returned to your last reading 
position when you re-open the book.  
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Device Settings 

Resetting Settings 
There are two levels of settings resets, geared to different situations: 

 Reset settings to factory defaults only. There is no de-registration or content removal. This 
does remove settings for a manually configured Wi-Fi hotspot. 

This might be useful in two situations: First, if you have customized a number of settings 
and decide to undo all of the changes. Second, if some settings change causes trouble, but 
you are not certain which one. 

 Reset settings to factory defaults, de-register your nook, and delete all content (B&N 
content and personal content) from the device. 

This is the approach to use if you are selling or giving the nook to someone else 
permanently, for their use. 

 



 

nook User Guide  89        

Policies 
 This chapter contains B&N policies that apply to your use of the nook. It also contains 
information from the FCC about your nook and a summary of information related to the 
radio. 

Nook Terms of Service 
These Terms of Service (this “Agreement”) is a legally binding agreement made by and 
between Barnes & Noble, Inc. (“we,” “us,” or “our”) and you regarding your use of your 
Nook™ eReader (“Nook”).   

THIS AGREEMENT SETS FORTH THE RIGHTS AND OBLIGATIONS APPLICABLE TO 
YOUR USE OF YOUR NOOK, SO PLEASE READ IT CAREFULLY BEFORE USING YOUR 
NOOK.  BY USING YOUR NOOK, YOU AGREE THAT YOU HAVE READ, 
UNDERSTAND AND AGREE TO BE BOUND BY THIS AGREEMENT.  IF YOU DO NOT 
AGREE TO BE SO BOUND, YOU MAY RETURN YOUR NOOK AND RELATED 
SOFTWARE (IN ITS ORIGINAL PACKAGING AND IN UNDAMAGED CONDITION) 
WITHIN THIRTY (30) DAYS OF THE DATE OF PURCHASE FOR A REFUND OF ITS 
PURCHASE PRICE PURSUANT TO THE RETURN PROCEDURES SET FORTH IN THE 
LIMITED WARRANTY.  

1. Using Your Nook. 

(a) Your Nook, the Service and Digital Content.  Your Nook is an electronic 
device that allows you to read digitized electronic content such as eBooks, digital periodicals 
and blogs (“Digital Content”).  Your Nook is also designed to connect wirelessly to the 
Internet to enable you to browse, preview, search for, purchase and/or download Digital 
Content; access the Barnes & Noble.com Web Site (the “Web Site”); and access other 
services, features, functions and promotions (collectively, the “Service”).   

(b) Terms of Use.  You must open a Barnes & Noble.com account and register 
your Nook in accordance with the Terms of Use on the Web Site (the “Terms of Use”) to use 
the Service.  In your use of the Service, in particular, your downloading and use of Digital 
Content, you must comply with the Terms of Use. Such Terms of Use will apply when you 
access the Web Site in connection with using your Nook.   
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(c) Wireless Connection.  Your Nook has built-in wireless Internet connectivity 
capabilities. We will use commercially reasonable efforts to provide wireless Internet 
connectivity at no additional cost to you.  The wireless connectivity is provided by a third party 
carrier and may be subject to restrictions and limitations imposed by such carrier, such as 
coverage area, file size and carrier policies.   

(d) No Responsibility for Digital Content.  Through your Nook, you will have 
access to a wide variety of Digital Content.  We do not exercise any editorial control over the 
Digital Content.  We provide only the Nook and Service, which allow you access to the Digital 
Content.  Under no circumstance will we be liable for any loss, damage or harm caused by 
your access to or reliance on the Digital Content.  You must determine whether the Digital 
Content that you access is appropriate, useful, accurate and complete.  Your use of the Service 
is solely at your own risk.   

2. License and Intellectual Property. 

(a) License.  Subject to your compliance with and the terms and conditions of this 
Agreement, we grant you a non-exclusive, revocable license to make personal, non-
commercial use of: (i) the Service; (ii) the software loaded onto your Nook, as may be 
updated, modified, added to or upgraded from time to time (the “Software”); and (iii) any 
printed or electronic documentation for such Software (the “Documentation”), all solely for 
the purposes that we intend, as described on the Web Site and in the Documentation.   

(b) Third-Party Software.  Certain portions of the Software are subject to separate 
licensing terms as set forth in Attachment 1.  By using your Nook, you agree that you have 
read, understand and agree to be bound by such terms.  The licensors listed in Attachment 1 
are intended third-party beneficiaries of the applicable terms of Attachment 1, this Section 2 
and Section 7. 
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(c) Reservation of Rights.  The sale of your Nook to you does not transfer to you 
any right, title or interest in or to any of our intellectual property rights or those of our 
suppliers or licensors.  For example, all Software is either owned by us or is the property of 
our suppliers or licensors.  The Software has been licensed, not sold, to you.  Your Nook, the 
Service or methods or processes related to either of them may be covered by one or more 
patents or pending patent applications.  Nook™, Barnes & Noble and B&N are our 
trademarks, © 2009 BARNES & NOBLE, INC.  ALL RIGHTS RESERVED.  Other trademarks 
shown on your Nook or through the Service are owned by our suppliers or licensors.  Other 
than the limited license granted to you in this Section 2, you have no other right, title or 
interest in the Service, Software or Documentation.  Any rights not expressly granted to you 
are fully reserved by us and our suppliers or licensors, as applicable, and no such rights are 
conferred by estoppel, operation of law, implication or otherwise.   

(d) Restrictions.  Except as may be expressly permitted by this Agreement, you 
may not. directly or indirectly:  (i) use the Software on any other device other than your Nook; 
(ii) use, copy, modify, distribute copies of, display or transmit the Software; (iii) disassemble, 
reverse engineer, emulate, decompile, tamper with or otherwise attempt to discover the 
source code of the Software or technology used to provide the Service; (iv) bypass, modify, 
defeat, tamper with or circumvent any of the security features of your Nook or the Service, 
including, without limitation, altering any digital rights management functionality of your Nook 
or Software; or (v) share access to the Software or Service, whether through a network, resale 
or other means.   

(e) U.S. Government End Users.  The Software and Documentation are 
“commercial computer software” or “commercial computer software documentation” as 
those terms are defined in 48 C.F.R. 252.227-7014(a)(1) (2007) and 252.227-7014(a)(5) 
(2007).  The U.S. Government’s rights with respect to the Software and Documentation are 
limited by this Agreement pursuant to FAR § 12.212 (Computer Software) (1995) and 12.211 
(Technical Data) (1995) and/or DFAR 227.7202-3, as applicable.  As such, the Software and 
Documentation are being licensed to the U.S. Government end users:  (i) only as “Commercial 
Items” as that term is defined in FAR 2.101 generally and as incorporated in DFAR 212.102; 
and (ii) with only those limited rights as are granted to the public pursuant to this Agreement.  
Under no circumstance will the U.S. Government or its end users be granted any greater rights 
than we grant to other users, as provided for in this Agreement. 
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3. Prohibited Conduct.  In your use of your Nook or the Service, you may not:  (i) 
transfer the Digital Content from one electronic reading device to another without maintaining 
the applicable digital rights management solution for that Digital Content; (ii) infringe any 
patent, trademark, trade secret, copyright, right of publicity or any other right of any party; (iii) 
violate any law, rule or regulation, including, without limitation, U.S. export control laws; (iv) 
copy, transfer, sublicense, assign, rent, lease, lend, resell or in any way transfer any rights to, or 
all or any portion of, the Digital Content to any third party, except as expressly permitted by 
the Terms of Use; (v) broadcast, transmit or distribute the Digital Content in any manner, such 
as online streaming or making the Digital Content available for download; (vi) interfere with or 
damage the Service, including, without limitation, through the use of viruses, cancel bots, 
Trojan horses, harmful code, flood pings, denial of service attacks, packet or IP spoofing, 
forged routing or electronic mail address information or similar methods or technology; (vii) 
violate any third-party contract or policy governing the Service, Software or Digital Content; 
(viii) open, modify, service or tamper with your Nook; (ix) engage in any activity that interferes 
with any third party’s ability to use or enjoy the Service; (x) delete, destroy or alter in any 
manner the proprietary rights notices, markings and legends appearing on the Digital Content, 
Nook, Software or Service; (xi) use the wireless connectivity provided by us for any other 
purpose other than in connection with the Service; or (xii) assist or encourage any third party 
in engaging in any activity prohibited by this Agreement.   

4. Privacy and Security.  

(a) Privacy.  You agree that we may use, collect and share your information in accordance 
with our Privacy Policy.  In particular, we will collect, use and/or disclose information regarding 
you and your use of your Nook and the Service in order to:  (i) provide the Service to you; (ii) 
permit you to engage in activities that you initiate through the Service, such as purchasing 
Digital Content and reviewing products; and (iii) analyze, operate, support, maintain and 
improve the Nook or the Service. 

(b) Security.  We employ measures designed to ensure the security of the Service, but, as 
provided below, make no guarantees in this regard. 

5. Support.  We have no obligation to maintain or support the Software or the Service.  
We and our suppliers or licensors may, without further notice to you, periodically access your 
Nook remotely to update, modify, add to or upgrade the Software.  In rare instances, such 
updates, modifications, additions or upgrades may cause data loss or other issues.  You are 
solely responsible for regularly backing up the data stored on your Nook to prevent this from 
occurring.    
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6. Indemnification.  You will defend, indemnify and hold us and our employees, 
representatives, agents, attorneys, affiliates, directors, officers, managers and shareholders (the 
“Indemnified Parties”) harmless from any damage, loss, cost or expense (including, without 
limitation, attorneys’ fees and costs) incurred in connection with any third-party claim, demand 
or action (“Claim”) brought or asserted against any of the Indemnified Parties arising from, 
related to, or connected with your alleged breach of this Agreement.  If you are obligated to 
provide indemnification pursuant to this provision, we may, in our sole and absolute discretion, 
control the disposition of any Claim at your sole cost and expense.  Without limitation of the 
foregoing, you may not settle, compromise or in any other manner dispose of any Claim 
without our written consent.   

7. DISCLAIMERS; EXCLUSIONS AND LIMITATIONS. 

(a) DISCLAIMER OF WARRANTIES.  EXCEPT FOR THE ONE-YEAR LIMITED 
WARRANTY THAT WE PROVIDE FOR YOUR NOOK, WE AND OUR SUPPLIERS AND 
LICENSORS PROVIDE THE NOOK, DIGITAL CONTENT, SOFTWARE AND SERVICE ON 
AN “AS IS” AND “AS AVAILABLE” BASIS WITHOUT ANY REPRESENTATION 
WARRANTY WHATSOEVER.  THE USE OF THE SERVICE, NOOK, DIGITAL CONTENT 
AND SOFTWARE IS AT YOUR SOLE RISK.  WE DO NOT REPRESENT OR WARRANT 
THAT THE NOOK, THE SOFTWARE, THE SERVICE OR THE DIGITAL CONTENT, OR 
ITS OR THEIR USE WILL: (I) BE UNINTERRUPTED OR SECURE; (II) BE FREE OF DEFECTS, 
INACCURACIES OR ERRORS; OR (III) MEET YOUR REQUIREMENTS.  WE HEREBY 
DISCLAIM ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF FITNESS FOR A PARTICULAR 
PURPOSE, HIDDEN OR LATENT DEFECTS, SECURITY, MERCHANTABILITY, QUIET 
ENJOYMENT AND NON-INFRINGEMENT.   

(b) EXCLUSION OF DAMAGES.  TO THE MAXIMUM EXTENT PERMITTED BY 
LAW, WE WILL NOT BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY 
CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE OR OTHER INDIRECT DAMAGES 
ARISING FROM, RELATING TO OR CONNECTED WITH YOUR PURCHASE OR USE OF 
YOUR NOOK, THE SERVICE, THE SOFTWARE, OR THE DIGITAL CONTENT, 
INCLUDING, WITHOUT LIMITATION, LOST PROFITS, LOST REVENUE OR LOST DATA, 
REGARDLESS OF THE CAUSE OF ACTION ON WHICH THE CLAIM IS BASED, 
INCLUDING, WITHOUT LIMITATION, NEGLIGENCE, TORT, CONTRACT, STRICT 
LIABILITY, PRODUCT DEFECT OR MISREPRESENTATION, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 
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(c) LIMITATION OF LIABILITY.  TO THE MAXIMUM EXTENT PERMITTED BY 
LAW, IN NO EVENT WILL OUR AGGREGATE LIABILITY ARISING FROM, RELATING TO, 
OR IN CONNECTION WITH THIS AGREEMENT (INCLUDING, WITHOUT 
LIMITATION, CLAIMS RELATING TO THE NOOK, THE DIGITAL CONTENT, THE 
SOFTWARE OR THE SERVICE) EXCEED THE PRICE PAID BY YOU FOR YOUR NOOK 
AND ALL DIGITAL CONTENT PURCHASED FROM US.   

(d) STATE LAW.  CERTAIN STATE LAWS DO NOT ALLOW LIMITATIONS 
ON IMPLIED WARRANTIES OR THE EXCLUSION OR LIMITATION OF CERTAIN 
DAMAGES.  AS SUCH, SOME OR ALL OF THE ABOVE DISCLAIMERS, EXCLUSIONS, OR 
LIMITATIONS MAY NOT APPLY TO YOU, AND YOU MAY HAVE ADDITIONAL 
RIGHTS.   

(e) ESSENTIAL PURPOSE.  UNLESS LIMITED OR MODIFIED BY APPLICABLE 
LAW, THE FOREGOING DISCLAIMERS, EXCLUSIONS AND LIMITATIONS APPLY, EVEN 
IF ANY REMEDY FAILS ITS ESSENTIAL PURPOSE.   

8. Force Majeure.  We will not be liable for failing to perform under this Agreement 
because of any event beyond our reasonable control, including, without limitation, a labor 
disturbance, an Internet outage or interruption of service, a communications outage, failure by 
a service provider or any other third party to perform, fire, an act of terrorism, natural disaster 
or war. 

9. Choice of Law.  The laws of the State of New York will govern and be used to 
interpret this Agreement, without giving effect to any principle that would allow for the 
application of the law of any other State.  For purposes of any Claim that is not subject to the 
arbitration procedures in Section 10 below, we both agree to submit to the nonexclusive 
personal jurisdiction of the courts located within New York County, New York and waive any 
objection to the laying of venue of any litigation in said courts. 



 

nook User Guide  95        

10. Dispute Resolution.  Any Claim arising from, relating to, or connected with this 
Agreement will be resolved through binding arbitration conducted by telephone, online or 
based solely upon written submissions where no in-person appearance is required.  In such 
cases, the arbitration will be administered by the American Arbitration Association under its 
Commercial Arbitration Rules (including, without limitation, the Supplementary Procedures for 
Consumer-Related Disputes, if applicable), and judgment on the award rendered by the 
arbitrator(s) may be entered in any court having jurisdiction thereof.  Alternatively, at our sole 
option, a Claim (including Claims for injunctive or other equitable relief) may be adjudicated by 
a court of competent jurisdiction located in New York County, New York.  Any Claim will be 
arbitrated or litigated, as the case may be, on an individual basis and shall not be consolidated 
with any Claim of any other party whether through class action proceedings, class arbitration 
proceedings or otherwise.  EACH OF THE PARTIES HEREBY KNOWINGLY, 
VOLUNTARILY AND INTENTIONALLY WAIVES ANY RIGHT IT MAY HAVE TO A TRIAL 
BY JURY IN RESPECT OF ANY LITIGATION ARISING OUT OF, RELATING TO OR IN 
CONNECTION WITH THIS AGREEMENT. FURTHER, EACH PARTY CERTIFIES THAT 
NO REPRESENTATIVE OR AGENT OF EITHER PARTY HAS REPRESENTED, EXPRESSLY 
OR OTHERWISE, THAT SUCH PARTY WOULD NOT, IN THE EVENT OF SUCH 
LITIGATION, SEEK TO ENFORCE THIS WAIVER OF RIGHT TO JURY TRIAL PROVISION.  
Each of the parties acknowledges that this section is a material inducement for the other party 
to enter into this Agreement.  You acknowledge and agree that, regardless of any statute or 
law to the contrary, any claim or cause of action you may have arising out of, relating to, or in 
connection with this Agreement must be filed within one calendar year after such claim or 
cause of action arises, or forever be barred.   

11. Termination.   

(a) Termination.  If we have a reasonable basis to believe that you have violated 
any term or condition of this Agreement or may cause us, our suppliers or licensors, or 
another user of the Service financial loss or legal liability, we may, in our sole discretion, upon 
notice to you, issue a warning, temporarily suspend, indefinitely suspend or terminate any of 
your rights to use or access all or any part of the Service.  You may terminate at any time… 
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(b) Effect of Termination.  Following termination or suspension, you will not be 
permitted to use the Service.  If your access to the Service is terminated or suspended, we 
reserve the right to exercise whatever means we deem necessary to prevent unauthorized 
access to the Service, including, but not limited to, technological barriers, IP mapping and our 
direct contacts with telecommunications companies.  This Agreement will survive indefinitely 
unless and until we choose to terminate it, regardless of whether any account you open is 
terminated by you or us or if you have the right to access or use the Service.  You are 
responsible for payment of all outstanding balances accrued up to and through the termination 
date.  All amounts paid to us are non-refundable, unless otherwise expressly provided for in 
this Agreement, the One-Year Limited Warranty, or the Terms of Service. 

12. Notice.  You hereby consent to receive electronic communications from us, whether 
addressed to the email address associated with your Barnes & Noble.com account or other 
email that you provide to us.  You acknowledge and agree that any communication via e-mail 
or by postings on this Web Site satisfies any legal requirement that such communications be 
made in writing.  Notice will be effective upon our sending of it.   

13. Changes to Service; Amendment.  We may, in our sole discretion, change, modify, 
suspend, make improvements to or discontinue any aspect of the Service, temporarily or 
permanently, at any time without notice to you, and we will not be liable for doing so.   

14. Assignment.  This Agreement and all of your rights and obligations under it may not be 
assignable or transferable by you without our prior written consent.  You may, however, sell, 
give away, or otherwise transfer your Nook; provided, however, that the person to whom you 
transfer your Nook registers the Nook in their name.  You will be responsible for all use of 
your Nook until that Nook is registered in their name.  Similarly, if you lend your Nook to 
someone, you will be responsible for that person’s use of your Nook.  We may freely assign or 
transfer this Agreement or any of our rights and obligations under it.   
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15. Additional Terms.  This Agreement contains the entire understanding between you and 
us regarding the use of the Nook and the Service, and supersedes all prior and 
contemporaneous agreements and understandings between you and us regarding this subject 
matter.  The provisions of this Agreement are intended to be severable. If for any reason any 
provision of this Agreement shall be held invalid or unenforceable in whole or in part in any 
applicable jurisdiction, such provision shall, as to such jurisdiction, be ineffective to the extent 
of such invalidity or unenforceability without in any manner affecting the validity or 
enforceability thereof in any other jurisdiction or the remaining provisions hereof in any other 
jurisdiction. Our failure to exercise or enforce any right or provision of this Agreement will not 
operate as a waiver of such right or provision.  This Agreement is binding upon each party and 
its successors and permitted assigns.   
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ATTACHMENT 1 

THIRD PARTY SOFTWARE TERMS 

1. Notwithstanding anything to the contrary in this Agreement, certain components of the 
Software are licensed subject to the General Public License Version 2.0, a copy of which is 
attached as Exhibit A (the “GPL License”).  You may not use these components except in 
compliance with the GPL License.  In addition, you may have additional rights with respect to 
such components under the GPL License, including, without limitation, the right to obtain the 
source code for such components from us.  You may obtain a copy of such source code by 
contacting us through the contact information provided on the Web Site.  We will provide 
such source code in accordance with the GPL License.   

2. Notwithstanding anything to the contrary in this Agreement, certain components of the 
Software (as defined herein) are licensed subject to the Apache License, Version 2.0, a copy of 
which is attached as Exhibit B (the “Apache License”).  You may not use these components 
except in compliance with the Apache License.  In addition, you may have additional rights with 
respect to such components under the Apache License.  Unless required by applicable law or 
agreed to in writing, software distributed under the Apache License is distributed on an "AS IS" 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or 
implied. See the Apache License for the specific language governing permissions and limitations 
under the Apache License. 

3. Notwithstanding anything to the contrary in this Agreement, the Software includes 
software developed by Google, Inc. and its affiliates (“Google Software”).  Copyright © 
Google, Inc. and its affiliates.  All rights reserved.  Redistribution and use in source and binary 
forms, with or without modification, are permitted provided that the following conditions are 
met: (a) Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer; (b) Redistributions in binary form must reproduce the 
above copyright notice, this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution; (c) Neither the name of Google, Inc. 
nor the names of its contributors may be used to endorse or promote products derived from 
this software without specific prior written permission.  THE GOOGLE SOFTWARE IS 
PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
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PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THE 
GOOGLE SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.   

4. Notwithstanding anything to the contrary in this Agreement, the Software includes 
software developed by Marvell International Ltd. (“Marvell”) and its affiliates (“Marvell 
Software”).  Copyright © Marvell International Ltd. and its affiliates.  All rights reserved.  
Redistribution and use in binary form, without modification, are permitted provided that the 
following conditions are met:  (a) Redistributions must reproduce the above copyright notice 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution; (b) Neither the name of Marvell International Ltd. nor the names of its suppliers 
may be used to endorse or promote products derived from the Marvell Software without 
specific prior written permission; (c) No reverse engineering, decompilation, or disassembly of 
the Marvell Software is permitted. Marvell International Ltd. grants a world-wide, royalty-free, 
non-exclusive license under patents it now or hereafter owns or controls to make, have made, 
use, import, offer to sell and sell ("Utilize") the Marvell Software, but solely to the extent that 
any such patent is necessary to Utilize the Marvell Software alone, or in combination with an 
operating system licensed under an approved Open Source license as listed by the Open 
Source Initiative at http://opensource.org/licenses. The patent license shall not apply to any 
other combinations which include the Marvell Software. No hardware per se is licensed 
hereunder.  THE MARVELL SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS 
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THE MARVELL 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.  THE 
COLLECTIVE LIABILITY OF MARVELL, IT’S AFFILIATES AND THEIR SUPPLIERS SHALL BE 
LIMITED TO U.S. $100.00. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING 
ANY FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITED REMEDY. IN JURISDICTIONS 
THAT PROHIBIT EXCLUSION OF LIABILITY OR LIMITATION OF IMPLIED 
WARRANTIES, THE ABOVE LIMITATIONS AND EXCLUSIONS MAY BE LIMITED IN 
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THEIR APPLICATION TO YOU AND, DEPENDING ON LOCAL LAW, YOU MAY HAVE 
OTHER SPECIFIC LEGAL RIGHTS. 

 

5. Notwithstanding anything to the contrary in this Agreement, the Software includes 
software developed by The FreeType Project (“FreeType Software”).  Copyright © 2006 The 
FreeType Project (www.freetype.org).  All rights reserved.  The FreeType Software is licensed 
subject to The FreeType Project License, a copy of which is attached as Exhibit C (the 
“FreeType License”).  You may not use these components except in compliance with the 
FreeType License.  In addition, you may have additional rights with respect to such 
components under the FreeType License.  
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Exhibit A 

GPL Version 2 

GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

 

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 51 Franklin St, Fifth Floor, Boston, 
MA  02110-1301  USA 

Everyone is permitted to copy and distribute verbatim copies of this license document, but 
changing it is not allowed. 

Preamble 

The licenses for most software are designed to take away your freedom to share and change 
it.  By contrast, the GNU General Public License is intended to guarantee your freedom to 
share and change free software--to make sure the software is free for all its users.  This 
General Public License applies to most of the Free Software Foundation's software and to any 
other program whose authors commit to using it.  (Some other Free Software Foundation 
software is covered by the GNU Library General Public License instead.)  You can apply it to 
your programs, too. 

When we speak of free software, we are referring to freedom, not price.  Our General Public 
Licenses are designed to make sure that you have the freedom to distribute copies of free 
software (and charge for this service if you wish), that you receive source code or can get it if 
you want it, that you can change the software or use pieces of it in new free programs; and 
that you know you can do these things. 

To protect your rights, we need to make restrictions that forbid anyone to deny you these 
rights or to ask you to surrender the rights. These restrictions translate to certain 
responsibilities for you if you distribute copies of the software, or if you modify it. 

For example, if you distribute copies of such a program, whether gratis or for a fee, you must 
give the recipients all the rights that you have.  You must make sure that they, too, receive or 
can get the source code.  And you must show them these terms so they know their rights. 

We protect your rights with two steps: (1) copyright the software, and (2) offer you this 
license which gives you legal permission to copy, distribute and/or modify the software. 
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Also, for each author's protection and ours, we want to make certain that everyone 
understands that there is no warranty for this free software.  If the software is modified by 
someone else and passed on, we want its recipients to know that what they have is not the 
original, so that any problems introduced by others will not reflect on the original authors' 
reputations. 

Finally, any free program is threatened constantly by software patents.  We wish to avoid the 
danger that redistributors of a free program will individually obtain patent licenses, in effect 
making the program proprietary.  To prevent this, we have made it clear that any patent must 
be licensed for everyone's free use or not licensed at all. 

The precise terms and conditions for copying, distribution and modification follow. 

GNU GENERAL PUBLIC LICENSE 

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 

0. This License applies to any program or other work which contains a notice placed by the 
copyright holder saying it may be distributed under the terms of this General Public License.  
The "Program", below, refers to any such program or work, and a "work based on the 
Program" means either the Program or any derivative work under copyright law: that is to say, 
a work containing the Program or a portion of it, either verbatim or with modifications and/or 
translated into another language.  (Hereinafter, translation is included without limitation in the 
term "modification".)  Each licensee is addressed as "you". 

Activities other than copying, distribution and modification are not covered by this License; 
they are outside its scope.  The act of running the Program is not restricted, and the output 
from the Program is covered only if its contents constitute a work based on the Program 
(independent of having been made by running the Program). Whether that is true depends on 
what the Program does. 

1. You may copy and distribute verbatim copies of the Program's source code as you receive 
it, in any medium, provided that you conspicuously and appropriately publish on each copy an 
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer 
to this License and to the absence of any warranty; and give any other recipients of the 
Program a copy of this License along with the Program. 

You may charge a fee for the physical act of transferring a copy, and you may at your option 
offer warranty protection in exchange for a fee.  



 

nook User Guide  103        

2. You may modify your copy or copies of the Program or any portion of it, thus forming a 
work based on the Program, and copy and distribute such modifications or work under the 
terms of Section 1 above, provided that you also meet all of these conditions: 

a) You must cause the modified files to carry prominent notices stating that you changed the 
files and the date of any change. 

b) You must cause any work that you distribute or publish, that in whole or in part contains or 
is derived from the Program or any part thereof, to be licensed as a whole at no charge to all 
third parties under the terms of this License. 

c) If the modified program normally reads commands interactively when run, you must cause 
it, when started running for such interactive use in the most ordinary way, to print or display 
an announcement including an appropriate copyright notice and a notice that there is no 
warranty (or else, saying that you provide a warranty) and that users may redistribute the 
program under these conditions, and telling the user how to view a copy of this License.  
(Exception: if the Program itself is interactive but does not normally print such an 
announcement, your work based on the Program is not required to print an announcement.) 

These requirements apply to the modified work as a whole.  If identifiable sections of that 
work are not derived from the Program, and can be reasonably considered independent and 
separate works in themselves, then this License, and its terms, do not apply to those sections 
when you distribute them as separate works.  But when you distribute the same sections as 
part of a whole which is a work based on the Program, the distribution of the whole must be 
on the terms of this License, whose permissions for other licensees extend to the entire 
whole, and thus to each and every part regardless of who wrote it. 

Thus, it is not the intent of this section to claim rights or contest your rights to work written 
entirely by you; rather, the intent is to exercise the right to control the distribution of 
derivative or collective works based on the Program. 

In addition, mere aggregation of another work not based on the Program with the Program (or 
with a work based on the Program) on a volume of a storage or distribution medium does not 
bring the other work under the scope of this License. 

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object 
code or executable form under the terms of Sections 1 and 2 above provided that you also do 
one of the following:  
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a) Accompany it with the complete corresponding machine-readable source code, which must 
be distributed under the terms of Sections 1 and 2 above on a medium customarily used for 
software interchange; or,  

 b) Accompany it with a written offer, valid for at least three years, to give any third party, for a 
charge no more than your cost of physically performing source distribution, a complete 
machine-readable copy of the corresponding source code, to be distributed under the terms 
of Sections 1 and 2 above on a medium customarily used for software interchange; or, 

c) Accompany it with the information you received as to the offer to distribute corresponding 
source code.  (This alternative is allowed only for noncommercial distribution and only if you 
received the program in object code or executable form with such an offer, in accord with 
Subsection b above.) 

The source code for a work means the preferred form of the work for making modifications to 
it.  For an executable work, complete source code means all the source code for all modules it 
contains, plus any associated interface definition files, plus the scripts used to control 
compilation and installation of the executable.  However, as a special exception, the source 
code distributed need not include anything that is normally distributed (in either source or 
binary form) with the major components (compiler, kernel, and so on) of the operating system 
on which the executable runs, unless that component itself accompanies the executable. 

If distribution of executable or object code is made by offering access to copy from a 
designated place, then offering equivalent access to copy the source code from the same place 
counts as distribution of the source code, even though third parties are not compelled to copy 
the source along with the object code.  

4. You may not copy, modify, sublicense, or distribute the Program except as expressly 
provided under this License.  Any attempt otherwise to copy, modify, sublicense or distribute 
the Program is void, and will automatically terminate your rights under this License. However, 
parties who have received copies, or rights, from you under this License will not have their 
licenses terminated so long as such parties remain in full compliance. 

5. You are not required to accept this License, since you have not signed it.  However, nothing 
else grants you permission to modify or distribute the Program or its derivative works.  These 
actions are prohibited by law if you do not accept this License.  Therefore, by modifying or 
distributing the Program (or any work based on the Program), you indicate your acceptance of 
this License to do so, and all its terms and conditions for copying, distributing or modifying the 
Program or works based on it. 
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6. Each time you redistribute the Program (or any work based on the Program), the recipient 
automatically receives a license from the original licensor to copy, distribute or modify the 
Program subject to these terms and conditions.  You may not impose any further restrictions 
on the recipients' exercise of the rights granted herein. You are not responsible for enforcing 
compliance by third parties to this License. 

7. If, as a consequence of a court judgment or allegation of patent infringement or for any 
other reason (not limited to patent issues), conditions are imposed on you (whether by court 
order, agreement or otherwise) that contradict the conditions of this License, they do not 
excuse you from the conditions of this License.  If you cannot distribute so as to satisfy 
simultaneously your obligations under this License and any other pertinent obligations, then as 
a consequence you may not distribute the Program at all.  For example, if a patent license 
would not permit royalty-free redistribution of the Program by all those who receive copies 
directly or indirectly through you, then the only way you could satisfy both it and this License 
would be to refrain entirely from distribution of the Program.  

If any portion of this section is held invalid or unenforceable under any particular circumstance, 
the balance of the section is intended to apply and the section as a whole is intended to apply 
in other circumstances. 

It is not the purpose of this section to induce you to infringe any patents or other property 
right claims or to contest validity of any such claims; this section has the sole purpose of 
protecting the integrity of the free software distribution system, which is implemented by 
public license practices.  Many people have made generous contributions to the wide range of 
software distributed through that system in reliance on consistent application of that system; it 
is up to the author/donor to decide if he or she is willing to distribute software through any 
other system and a licensee cannot impose that choice.  

This section is intended to make thoroughly clear what is believed to be a consequence of the 
rest of this License. 

8. If the distribution and/or use of the Program is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the Program 
under this License may add an explicit geographical distribution limitation excluding those 
countries, so that distribution is permitted only in or among countries not thus excluded.  In 
such case, this License incorporates the limitation as if written in the body of this License. 

9. The Free Software Foundation may publish revised and/or new versions of the General 
Public License from time to time.  Such new versions will be similar in spirit to the present 
version, but may differ in detail to address new problems or concerns. 
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Each version is given a distinguishing version number.  If the Program specifies a version 
number of this License which applies to it and "any later version", you have the option of 
following the terms and conditions either of that version or of any later version published by 
the Free Software Foundation.  If the Program does not specify a version number of this 
License, you may choose any version ever published by the Free Software Foundation. 

10. If you wish to incorporate parts of the Program into other free programs whose 
distribution conditions are different, write to the author to ask for permission.  For software 
which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; 
we sometimes make exceptions for this.  Our decision will be guided by the two goals of 
preserving the free status of all derivatives of our free software and of promoting the sharing 
and reuse of software generally. 

NO WARRANTY 

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS 
AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY 
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME 
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE 
TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE 
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING 
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A 
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF 
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 

END OF TERMS AND CONDITIONS 

How to Apply These Terms to Your New Programs 
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If you develop a new program, and you want it to be of the greatest possible use to the public, 
the best way to achieve this is to make it free software which everyone can redistribute and 
change under these terms. 

To do so, attach the following notices to the program.  It is safest to attach them to the start of 
each source file to most effectively convey the exclusion of warranty; and each file should have 
at least the "copyright" line and a pointer to where the full notice is found. 

<one line to give the program's name and a brief idea of what it does.> 

Copyright (C) <year>  <name of author> 

This program is free software; you can redistribute it and/or modify it under the terms of the 
GNU General Public License as published by the Free Software Foundation; either version 2 of 
the License, or (at your option) any later version. 

This program is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A 
PARTICULAR PURPOSE.  See the GNU General Public License for more details. 

You should have received a copy of the GNU General Public License along with this program; 
if not, write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA  
02110-1301  USA 

Also add information on how to contact you by electronic and paper mail. 

If the program is interactive, make it output a short notice like this when it starts in an 
interactive mode: 

Gnomovision version 69, Copyright (C) year name of author 

Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w'. 

This is free software, and you are welcome to redistribute it under certain conditions; type 
`show c' for details. 

The hypothetical commands `show w' and `show c' should show the appropriate parts of the 
General Public License.  Of course, the commands you use may be called something other 
than `show w' and `show c'; they could even be mouse-clicks or menu items--whatever suits 
your program. 
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You should also get your employer (if you work as a programmer) or your school, if any, to 
sign a "copyright disclaimer" for the program, if necessary.  Here is a sample; alter the names: 

Yoyodyne, Inc., hereby disclaims all copyright interest in the program 

`Gnomovision' (which makes passes at compilers) written by James Hacker. 

<signature of Ty Coon>, 1 April 1989 

Ty Coon, President of Vice 

This General Public License does not permit incorporating your program into proprietary 
programs.  If your program is a subroutine library, you may consider it more useful to permit 
linking proprietary applications with the library.  If this is what you want to do, use the GNU 
Library General Public License instead of this License. 

 

Exhibit B 

Apache License 

 

Apache License 

Version 2.0, January 2004 

http://www.apache.org/licenses/  

 

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION  

1. Definitions. 

"License" shall mean the terms and conditions for use, reproduction, and distribution as 
defined by Sections 1 through 9 of this document.  

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is 
granting the License.  

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are 
controlled by, or are under common control with that entity. For the purposes of this 
definition, "control" means (i) the power, direct or indirect, to cause the direction or 
management of such entity, whether by contract or otherwise, or (ii) ownership of fifty 
percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.  
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"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.  

"Source" form shall mean the preferred form for making modifications, including but not limited 
to software source code, documentation source, and configuration files.  

"Object" form shall mean any form resulting from mechanical transformation or translation of a 
Source form, including but not limited to compiled object code, generated documentation, and 
conversions to other media types.  

"Work" shall mean the work of authorship, whether in Source or Object form, made available 
under the License, as indicated by a copyright notice that is included in or attached to the work 
(an example is provided in the Appendix below).  

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on 
(or derived from) the Work and for which the editorial revisions, annotations, elaborations, or 
other modifications represent, as a whole, an original work of authorship. For the purposes of 
this License, Derivative Works shall not include works that remain separable from, or merely 
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.  

"Contribution" shall mean any work of authorship, including the original version of the Work 
and any modifications or additions to that Work or Derivative Works thereof, that is 
intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an 
individual or Legal Entity authorized to submit on behalf of the copyright owner. For the 
purposes of this definition, "submitted" means any form of electronic, verbal, or written 
communication sent to the Licensor or its representatives, including but not limited to 
communication on electronic mailing lists, source code control systems, and issue tracking 
systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise 
designated in writing by the copyright owner as "Not a Contribution."  

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a 
Contribution has been received by Licensor and subsequently incorporated within the Work.  

2. Grant of Copyright License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-
free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, 
publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or 
Object form.  

3. Grant of Patent License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-
free, irrevocable (except as stated in this section) patent license to make, have made, use, offer 
to sell, sell, import, and otherwise transfer the Work, where such license applies only to those 
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patent claims licensable by such Contributor that are necessarily infringed by their 
Contribution(s) alone or by combination of their Contribution(s) with the Work to which such 
Contribution(s) was submitted. If You institute patent litigation against any entity (including a 
cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any 
patent licenses granted to You under this License for that Work shall terminate as of the date 
such litigation is filed.  

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works 
thereof in any medium, with or without modifications, and in Source or Object form, provided 
that You meet the following conditions:  

a. You must give any other recipients of the Work or Derivative Works a copy of this 
License; and  
 

b. You must cause any modified files to carry prominent notices stating that You changed 
the files; and  
 

c. You must retain, in the Source form of any Derivative Works that You distribute, all 
copyright, patent, trademark, and attribution notices from the Source form of the 
Work, excluding those notices that do not pertain to any part of the Derivative Works; 
and  
 

d. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative 
Works that You distribute must include a readable copy of the attribution notices 
contained within such NOTICE file, excluding those notices that do not pertain to any 
part of the Derivative Works, in at least one of the following places: within a NOTICE 
text file distributed as part of the Derivative Works; within the Source form or 
documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally 
appear. The contents of the NOTICE file are for informational purposes only and do 
not modify the License. You may add Your own attribution notices within Derivative 
Works that You distribute, alongside or as an addendum to the NOTICE text from the 
Work, provided that such additional attribution notices cannot be construed as 
modifying the License.  

You may add Your own copyright statement to Your modifications and may provide additional 
or different license terms and conditions for use, reproduction, or distribution of Your 
modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, 
and distribution of the Work otherwise complies with the conditions stated in this License.  
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5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution 
intentionally submitted for inclusion in the Work by You to the Licensor shall be under the 
terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of any 
separate license agreement you may have executed with Licensor regarding such 
Contributions.  

6. Trademarks. This License does not grant permission to use the trade names, trademarks, 
service marks, or product names of the Licensor, except as required for reasonable and 
customary use in describing the origin of the Work and reproducing the content of the 
NOTICE file.  

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor 
provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, 
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, 
MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely 
responsible for determining the appropriateness of using or redistributing the Work and 
assume any risks associated with Your exercise of permissions under this License.  

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including 
negligence), contract, or otherwise, unless required by applicable law (such as deliberate and 
grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for 
damages, including any direct, indirect, special, incidental, or consequential damages of any 
character arising as a result of this License or out of the use or inability to use the Work 
(including but not limited to damages for loss of goodwill, work stoppage, computer failure or 
malfunction, or any and all other commercial damages or losses), even if such Contributor has 
been advised of the possibility of such damages.  

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative 
Works thereof, You may choose to offer, and charge a fee for, acceptance of support, 
warranty, indemnity, or other liability obligations and/or rights consistent with this License. 
However, in accepting such obligations, You may act only on Your own behalf and on Your 
sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, 
defend, and hold each Contributor harmless for any liability incurred by, or claims asserted 
against, such Contributor by reason of your accepting any such warranty or additional liability.  

END OF TERMS AND CONDITIONS  

APPENDIX: How to apply the Apache License to your work  

To apply the Apache License to your work, attach the following boilerplate notice, with the 
fields enclosed by brackets "[]" replaced with your own identifying information. (Don't include 
the brackets!) The text should be enclosed in the appropriate comment syntax for the file 
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format. We also recommend that a file or class name and description of purpose be included 
on the same "printed page" as the copyright notice for easier identification within third-party 
archives.  

Copyright [yyyy] [name of copyright owner] Licensed under the Apache License, Version 2.0 
(the "License"); you may not use this file except in compliance with the License. You may 
obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless 
required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY 
KIND, either express or implied. See the License for the specific language governing 
permissions and limitations under the License.  

 

Exhibit C 

FreeType License 

This software is based in part on the work of the FreeType Team. 

---------------------- 

The FreeType Project LICENSE 

---------------------- 

2006-Jan-27 

Copyright 1996-2002, 2006 by 

David Turner, Robert Wilhelm, and Werner Lemberg 

Introduction 

============ 

The FreeType  Project is distributed in  several archive packages; some of them may contain, in 
addition to the FreeType font engine, various tools and  contributions which rely on, or  relate 
to, the FreeType Project. 

This  license applies  to all  files found  in such  packages, and which do not  fall under their own 
explicit  license.  The license affects  thus  the  FreeType   font  engine,  the  test  programs, 
documentation and makefiles, at the very least. 
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This  license   was  inspired  by  the  BSD,   Artistic,  and  IJG (Independent JPEG  Group) 
licenses, which  all encourage inclusion and  use of  free  software in  commercial  and freeware  
products alike.  As a consequence, its main points are that: 

We don't promise that this software works. However, we will be interested in any kind of bug 
reports. (`as is' distribution) 

You can  use this software for whatever you  want, in parts or full form, without having to pay 
us. (`royalty-free' usage) 

You may not pretend that  you wrote this software.  If you use it, or only parts of it,  in a 
program,  you must acknowledge somewhere in your documentation that you have used the 
FreeType code. (`credits') 

We specifically permit and encourage the inclusion of this software, with or without 
modifications, in commercial products.   

We  disclaim  all warranties  covering The  FreeType Project and assume no liability related to 
The FreeType Project. 

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance 
with this license.  We thus encourage you to use the following text: 

Portions of this software are copyright © <year> The FreeType Project (www.freetype.org).  
All rights reserved. 

Please replace <year> with the value from the FreeType version you actually use. 

Legal Terms 

=========== 

0. Definitions 

-------------- 

Throughout this license,  the terms `package', `FreeType Project', and  `FreeType  archive' 
refer to the set of files originally distributed by the authors (David Turner,  Robert Wilhelm, 
and  Werner Lemberg) as the `FreeType Project', be they named as alpha, beta or final 
release. 

`You' refers to  the licensee, or person using  the project, where `using' is a generic term 
including compiling the project's source code as  well as linking it  to form a `program' or 
`executable'.  This program is  referred to  as  `a program  using the  FreeType engine'. 
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This license applies to all files distributed in the original FreeType  Project,   including  all  
source   code,  binaries and documentation, unless otherwise stated in the file in its original, 
unmodified form as  distributed in the original archive. 

If you are unsure whether or not a particular file is covered by this license, you must contact us 
to verify this. 

The FreeType  Project is copyright (C) 1996-2000  by David Turner, Robert Wilhelm, and 
Werner Lemberg.  All rights reserved except as specified below. 

1. No Warranty 

-------------- 

THE FREETYPE PROJECT IS PROVIDED `AS IS' WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR  A PARTICULAR PURPOSE.  IN NO EVENT 
WILL ANY OF THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
DAMAGES CAUSED BY THE USE OR THE INABILITY TO USE, OF THE FREETYPE 
PROJECT.  

2. Redistribution 

----------------- 

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to 
use, execute, perform, compile, display, copy, create derivative works of, distribute and 
sublicense the  FreeType Project (in  both source and object code forms)  and  derivative 
works thereof  for  any purpose; and to authorize others to exercise some or all of the rights 
granted herein, subject to the following conditions: 

Redistribution of  source code must retain this license file (`FTL.TXT') unaltered; any additions, 
deletions or changes to the original  files must be clearly indicated in accompanying 
documentation. The  copyright notices of the unaltered, original files must be preserved in all 
copies of source files. 

Redistribution in binary form must provide a disclaimer that states that the software is based in 
part of the work of the FreeType Team, in the distribution documentation.  We also 
encourage you to put an URL to the FreeType web page in your documentation, though this 
isn't mandatory. 

These conditions apply to any software derived from or based on the FreeType Project, not 
just the unmodified files.  If you use our work, you must acknowledge us.  However, no fee 
need be paid to us. 

3. Advertising 
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-------------- 

Neither the  FreeType authors and  contributors nor you shall use the name of the other for 
commercial, advertising, or promotional purposes without specific prior written permission. 

We suggest, but do not require, that you use one or more of the following phrases to refer to 
this software in your documentation or advertising  materials: `FreeType Project',  `FreeType 
Engine', `FreeType library', or `FreeType Distribution'. 

As you have not signed this license, you are not required to accept it.  However, as the 
FreeType Project is  copyrighted material, only this license, or another one contracted with the 
authors, grants you  the right to use, distribute, and modify it.  Therefore, by using, distributing, 
or modifying the FreeType Project, you indicate that you understand and accept all the terms 
of this license. 

4. Contacts 

----------- 

There are two mailing lists related to FreeType: 

freetype@nongnu.org 

Discusses general use and applications of FreeType, as well as future and wanted additions to 
the  library and distribution. If  you are looking for support, start in this list if you haven't found 
anything to help you in the documentation. 

freetype-devel@nongnu.org 

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.  

Our home page can be found at 

http://www.freetype.org 

--- end of FTL.TXT --- 
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Warranty 

ONE YEAR LIMITED WARRANTY 

This Limited Warranty provides for specific legal rights with respect to your Nook™ eReader.  
Please review it carefully.  You may also have other rights, which vary from state to state. 

WHAT WARRANTIES APPLY TO MY NOOK? 

What is Covered? 

This Limited Warranty covers your Nook.  For purposes of this Limited Warranty, “Nook” 
means only the hardware comprising:  (i) your Nook eReader unit; and (ii) the peripherals 
included in the packaging with your Nook. 

Express Warranty 

Subject to the terms and conditions of this Limited Warranty, Barnes & Noble, Inc. (“B&N”) 
warrants to the original retail purchaser only (“you”) that your Nook will be free from defects 
in materials and workmanship under normal consumer use for a period of one (1) year from 
the date of original retail purchase (the “Warranty Period”).  This express warranty is not 
transferable to subsequent owners of the product.   

Implied Warranty 

You may also have implied warranties under the laws of some jurisdictions.  To the extent 
permitted by applicable law, such implied warranties are limited to the duration of the 
Warranty Period.  Some jurisdictions do not allow limitations on the duration of an implied 
warranty, so this limitation may not apply to you.  You may not assign or otherwise transfer 
such implied warranties.  However, some jurisdictions extend the protection of implied 
warranties to subsequent consumers, so this limitation may not apply to you.   

HOW DO I MAKE A WARRANTY CLAIM? 

To make a warranty claim, you should contact B&N at one of the following numbers during the 
Warranty Period:   

• Within the United States – 1 202 559-3882 

• Outside the United States – 1 202 559-3882 
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HOW DO I RETURN MY NOOK TO B&N? 

When you contact B&N at one of the numbers above, B&N will provide instructions to you as 
to how and where to return your Nook.  Your Nook must be shipped, prepaid and insured, in 
appropriate protective packaging, together with proof of purchase and the Return 
Authorization Number provided by B&N, to the address specified by B&N.  You must return 
your Nook within the timeframe provided by B&N.  You may also be required to provide a 
credit card to obtain an advance replacement before B&N receives your unit at its returns 
center.   

All returned Nooks become the property of B&N.   

Before you send your Nook to B&N, it is your responsibility to back up any data, software or 
files stored on your Nook because B&N will not return your Nook to you, unless it is not 
covered by this Limited Warranty and B&N has not provided an advance replacement.  B&N is 
not responsible for any loss of your data, software or files or for the cost of backing up your 
data, software or files.  

If you do not comply with the terms above or with B&N’s instructions, there may be delays in 
service or you may incur additional expenses.  In particular, if you do not return your Nook 
within the timeframe specified by B&N, B&N reserves the right to charge you the purchase 
price for a replacement Nook.  You will be solely responsible for any cost, expense, loss or the 
like relating to your failure to comply with such terms or B&N’s instructions. 

B&N DOES NOT PROVIDE, AND HEREBY DISCLAIMS, ANY EXPRESS OR IMPLIED 
WARRANTIES REGARDING ITS WARRANTY SERVICES, INCLUDING, WITHOUT 
LIMITATION, ALL DUTIES (IF ANY) OF WORKMANLIKE EFFORT AND OF REASONABLE 
CARE. 

WHAT WILL B&N DO WHEN IT RECEIVES MY NOOK?  

When B&N receives your Nook, it will examine it and determine whether it is covered by this 
Limited Warranty.  If, upon examination, B&N determines that your Nook is covered by this 
Limited Warranty, B&N will, within a reasonable period of time, at its option and at no 
additional charge, do one of the following: 

• replace the Nook with a new or refurbished model of equal or greater value; or 

• refund the purchase price you paid for the Nook.  
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If B&N replaces your Nook, B&N will bear the cost of sending a replacement Nook to you, 
freight prepaid.   

THE FOREGOING IS YOUR SOLE AND EXCLUSIVE REMEDY FOR BREACH OF 
WARRANTY.   

WHAT WOULD BE THE WARRANTY PERIOD IF MY NOOK IS 
REPLACED? 

If your Nook is replaced during the Warranty Period, it will be covered by this Limited 
Warranty for the remainder of the original Warranty Period or ninety (90) days from the date 
of shipment of the replaced Nook, whichever is longer. 

WHAT IF MY NOOK IS NOT COVERED BY THIS LIMITED WARRANTY? 

If your Nook is not covered by this Limited Warranty, B&N will return the Nook to you, at 
your expense, or will charge your credit card for any advance replacement Nook provided to 
you. 

WHAT IS NOT COVERED BY THE WARRANTY? 

This Limited Warranty does not cover damage or malfunctions caused by accident, disaster, 
misuse, abuse, negligence or other external causes; third-party products; Internet or 
telecommunications failures; commercial use; unauthorized opening, use, service, tampering, 
alteration, repair or modification; or inadequate packing or shipping procedures.  This Limited 
Warranty also does not cover cosmetic damage or normal wear and tear.  This Limited 
Warranty does not apply to Nooks sold as used, refurbished or reconditioned.  This Limited 
Warranty will be void if the Serial Number on the Nook has been removed, tampered with or 
defaced or if your Nook has been opened or serviced without authorization, tampered with, 
altered or modified.  Please note that opening the back cover of your Nook to change the 
battery, external SD card or back cover will not void this Limited Warranty.   

This Limited Warranty applies to the Nook only (i.e., the hardware), and not to the software 
within the Nook.  Please refer to the NOOK TERMS OF SERVICE for your rights and 
remedies with respect to such software.   

Similarly, this Limited Warranty does not cover downloaded data or materials, or accessories 
and peripherals, except as expressly provided above.   
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WHAT OTHER LEGAL TERMS APPLY TO THIS LIMITED WARRANTY? 

Disclaimer 

TO THE EXTENT PERMITTED BY APPLICABLE LAW, THIS LIMITED WARRANTY AND 
THE REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES, REMEDIES AND CONDITIONS, WHETHER ORAL, WRITTEN, 
STATUTORY, EXPRESS OR IMPLIED.  TO THE EXTENT PERMITTED BY APPLICABLE 
LAW, B&N SPECIFICALLY DISCLAIMS ANY AND ALL WARRANTIES AND 
CONDITIONS NOT EXPRESSLY PROVIDED FOR IN THIS LIMITED WARRANTY, 
INCLUDING, WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY, NON-
INFRINGEMENT, SECURITY, FITNESS FOR A PARTICULAR PURPOSE AND AGAINST 
HIDDEN OR LATENT DEFECTS. 

Modification 

No employee or representative of B&N or its affiliates or any third party is authorized to make 
any modification, extension or addition to this Limited Warranty.  If any term of this Limited 
Warranty is held to be illegal or unenforceable, the remaining terms of this Limited Warranty 
will remain in full force and effect. 

Exclusion of Indirect Damages 

TO THE MAXIMUM EXTENT PERMITTED BY LAW, NEITHER B&N NOR ITS AFFILIATES 
WILL BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY CONSEQUENTIAL, 
SPECIAL, INCIDENTAL, PUNITIVE OR OTHER INDIRECT DAMAGES ARISING FROM, 
RELATING TO OR CONNECTED WITH YOUR PURCHASE OR USE OF YOUR NOOK, 
INCLUDING, WITHOUT LIMITATION, LOST PROFITS, LOST REVENUE OR LOST DATA, 
REGARDLESS OF THE CAUSE OF ACTION ON WHICH THE CLAIM IS BASED, 
INCLUDING, WITHOUT LIMITATION, NEGLIGENCE, TORT, CONTRACT, STRICT 
LIABILITY, PRODUCT DEFECT OR MISREPRESENTATION, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES OCCURRING, AND EVEN IF ANY REMEDY FAILS OF 
ITS ESSENTIAL PURPOSE. 

Some states do not allow the exclusion or limitation of incidental or consequential damages, so 
the above exclusion may not apply to you. 

Applicable Law 

This Limited Warranty is valid only in the United States of America.  The laws of the State of 
New York, U.S.A. will apply to this Limited Warranty, though the laws of your state of 
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residence may apply to any tort claims and any claims under any consumer protection statutes, 
as provided under applicable law. 

FCC Notices 
FCC ID: XHHBNRZ100 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation. 

FEDERAL COMMUNICATIONS COMMISSION (FCC) STATEMENT INFORMATION 
TO THE USER  

CAUTION: Changes or modifications to the equipment not expressly approved by the party 
responsible for compliance could void the user’s authority to operate the equipment.  

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications. However, there is 
no guarantee that interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures:  

1. Reorient or relocate the receiving antenna.  

2. Increase the separation between the equipment and receiver.  

3. If applicable, connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected. 

4. Consult the dealer or an experienced radio / TV technician for help.  
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FCC Radiation Exposure Statement:
 
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. This device is designed for hand-held operation only. This transmitter must not
be co-located or operating in conjunction with any other antenna or transmitter except those
transmitters that are factory installed. 
 

Other Information Related to the Radio 

Also note the following: 

 Information about wireless connectivity is in the section “Wireless Connectivity.” 

 The nook has an Airplane mode that turns off the radio. It should be used on airplanes. For 
more information, see the section “Use on Airplanes.” 

 The nook should be fully off when stowed onboard an airplane. For more information, see 
the section “Checked Baggage.” 

 When around sensitive electronic equipment, ask whether you can use your nook. You 
might need to use Airplane mode.  In some places, for example an intensive care area in a 
hospital, you might be asked to not use your device. For more information, see “Electronic 
Equipment.” 

 Use a shielded USB cable when connecting your nook to a personal computer. The 
provided USB cable is shielded. 

 


	(c) Wireless Connection.  Your Nook has built-in wireless Internet connectivity capabilities. We will use commercially reasonable efforts to provide wireless Internet connectivity at no additional cost to you.  The wireless connectivity is provided by...
	(d) No Responsibility for Digital Content.  Through your Nook, you will have access to a wide variety of Digital Content.  We do not exercise any editorial control over the Digital Content.  We provide only the Nook and Service, which allow you access...
	2. License and Intellectual Property.
	(a) License.  Subject to your compliance with and the terms and conditions of this Agreement, we grant you a non-exclusive, revocable license to make personal, non-commercial use of: (i) the Service; (ii) the software loaded onto your Nook, as may be ...
	(b) Third-Party Software.  Certain portions of the Software are subject to separate licensing terms as set forth in Attachment 1.  By using your Nook, you agree that you have read, understand and agree to be bound by such terms.  The licensors listed ...
	(c) Reservation of Rights.  The sale of your Nook to you does not transfer to you any right, title or interest in or to any of our intellectual property rights or those of our suppliers or licensors.  For example, all Software is either owned by us or...
	(d) Restrictions.  Except as may be expressly permitted by this Agreement, you may not. directly or indirectly:  (i) use the Software on any other device other than your Nook; (ii) use, copy, modify, distribute copies of, display or transmit the Softw...
	(e) U.S. Government End Users.  The Software and Documentation are “commercial computer software” or “commercial computer software documentation” as those terms are defined in 48 C.F.R. 252.227-7014(a)(1) (2007) and 252.227-7014(a)(5) (2007).  The U.S...

	3. Prohibited Conduct.  In your use of your Nook or the Service, you may not:  (i) transfer the Digital Content from one electronic reading device to another without maintaining the applicable digital rights management solution for that Digital Conten...
	6. Indemnification.  You will defend, indemnify and hold us and our employees, representatives, agents, attorneys, affiliates, directors, officers, managers and shareholders (the “Indemnified Parties”) harmless from any damage, loss, cost or expense (...
	7. DISCLAIMERS; EXCLUSIONS AND LIMITATIONS.
	(a) DISCLAIMER OF WARRANTIES.  EXCEPT FOR THE ONE-YEAR LIMITED WARRANTY THAT WE PROVIDE FOR YOUR NOOK, WE AND OUR SUPPLIERS AND LICENSORS PROVIDE THE NOOK, DIGITAL CONTENT, SOFTWARE AND SERVICE ON AN “AS IS” AND “AS AVAILABLE” BASIS WITHOUT ANY REPRES...
	(b) EXCLUSION OF DAMAGES.  TO THE MAXIMUM EXTENT PERMITTED BY LAW, WE WILL NOT BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE OR OTHER INDIRECT DAMAGES ARISING FROM, RELATING TO OR CONNECTED WITH YOUR PURCHASE...
	(c) LIMITATION OF LIABILITY.  TO THE MAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT WILL OUR AGGREGATE LIABILITY ARISING FROM, RELATING TO, OR IN CONNECTION WITH THIS AGREEMENT (INCLUDING, WITHOUT LIMITATION, CLAIMS RELATING TO THE NOOK, THE DIGITAL CON...
	(d) STATE LAW.  Certain state laws do not allow limitations on implied warranties or the exclusion or limitation of certain damages.  AS SUCH, some or all of the above disclaimers, exclusions, or limitations may not apply to you, and you may have addi...
	(e) ESSENTIAL PURPOSE.  UNLESS LIMITED OR MODIFIED BY APPLICABLE LAW, THE FOREGOING DISCLAIMERS, EXCLUSIONS AND LIMITATIONS APPLY, EVEN IF ANY REMEDY FAILS ITS ESSENTIAL PURPOSE.

	8. Force Majeure.  We will not be liable for failing to perform under this Agreement because of any event beyond our reasonable control, including, without limitation, a labor disturbance, an Internet outage or interruption of service, a communication...
	9. Choice of Law.  The laws of the State of New York will govern and be used to interpret this Agreement, without giving effect to any principle that would allow for the application of the law of any other State.  For purposes of any Claim that is not...
	10. Dispute Resolution.  Any Claim arising from, relating to, or connected with this Agreement will be resolved through binding arbitration conducted by telephone, online or based solely upon written submissions where no in-person appearance is requir...
	11. Termination.
	(a) Termination.  If we have a reasonable basis to believe that you have violated any term or condition of this Agreement or may cause us, our suppliers or licensors, or another user of the Service financial loss or legal liability, we may, in our sol...
	(b) Effect of Termination.  Following termination or suspension, you will not be permitted to use the Service.  If your access to the Service is terminated or suspended, we reserve the right to exercise whatever means we deem necessary to prevent unau...

	12. Notice.  You hereby consent to receive electronic communications from us, whether addressed to the email address associated with your Barnes & Noble.com account or other email that you provide to us.  You acknowledge and agree that any communicati...
	13. Changes to Service; Amendment.  We may, in our sole discretion, change, modify, suspend, make improvements to or discontinue any aspect of the Service, temporarily or permanently, at any time without notice to you, and we will not be liable for do...
	14. Assignment.  This Agreement and all of your rights and obligations under it may not be assignable or transferable by you without our prior written consent.  You may, however, sell, give away, or otherwise transfer your Nook; provided, however, tha...
	15. Additional Terms.  This Agreement contains the entire understanding between you and us regarding the use of the Nook and the Service, and supersedes all prior and contemporaneous agreements and understandings between you and us regarding this subj...
	ATTACHMENT 1
	THIRD PARTY SOFTWARE TERMS
	1. Notwithstanding anything to the contrary in this Agreement, certain components of the Software are licensed subject to the General Public License Version 2.0, a copy of which is attached as Exhibit A (the “GPL License”).  You may not use these comp...
	2. Notwithstanding anything to the contrary in this Agreement, certain components of the Software (as defined herein) are licensed subject to the Apache License, Version 2.0, a copy of which is attached as Exhibit B (the “Apache License”).  You may no...


